DEVELOPMENT OF BRIDGE LOAD TESTING PROCESS FOR LOAD EVALUATION

Iowa DOT Project TR-445
CTRE Project 00-65

Sponsored by
the Iowa Department of Transportation
and the Iowa Highway Research Board

CTRE
Center for Transportation Research and Education
Bridge Engineering Center
Department of Civil, Construction and Environmental Engineering

IOWA STATE UNIVERSITY

Final Report · April 2003
The opinions, findings, and conclusions expressed in this publication are those of the authors and not necessarily those of the Iowa Department of Transportation.

CTRE’s mission is to develop and implement innovative methods, materials, and technologies for improving transportation efficiency, safety, and reliability while improving the learning environment of students, faculty, and staff in transportation-related fields.
DEVELOPMENT OF BRIDGE LOAD TESTING
PROCESS FOR LOAD EVALUATION

Project: TR-445

Principal Investigator
T.J. Wipf
Associate Director, Center for Transportation Research and Education

Co-Principal Investigators
B.M. Phares
Bridge Engineer, Center for Transportation Research and Education

F.W. Klaiber
Professor, Department of Civil and Construction Engineering

D.L. Wood
Manager, Engineering Laboratories, Department of Civil and Construction Engineering

Graduate Research Assistants
E. Mellingen, A. Samuelson
Student, Center for Transportation Research and Education

Authors
T.J. Wipf, B.M. Phares, F.W. Klaiber, D.L. Wood, E. Mellingen, A. Samuelson

Preparation of this report was financed in part through funds provided by the Iowa Department of Transportation through its research management agreement with the Center for Transportation Research and Education.

Center for Transportation Research and Education
Iowa State University
2901 South Loop Drive, Suite 3100
Ames, IA 50010-8632
Phone: 515-294-8103
Fax: 515-294-0467
www.ctre.iastate.edu

Final Report • April 2003
Recent reports indicate that of the over 25,000 bridges in Iowa, slightly over 7,000 (29%) are either structurally deficient or functionally obsolete. While many of these bridges may be strengthened or rehabilitated, some simply need to be replaced. Before implementing one of these options, one should consider performing a diagnostic load test on the structure to more accurately assess its load carrying capacity. Frequently, diagnostic load tests reveal strength and serviceability characteristics that exceed the predicted codified parameters. Usually, codified parameters are very conservative in predicting lateral load distribution characteristics and the influence of other structural attributes. As a result, the predicted rating factors are typically conservative. In cases where theoretical calculations show a structural deficiency, it may be very beneficial to apply a “tool” that utilizes a more accurate theoretical model which incorporates field-test data. At a minimum, this approach results in more accurate load ratings and many times results in increased rating factors. Bridge Diagnostics, Inc. (BDI), developed hardware and software that is specially designed for performing bridge ratings based on data obtained from physical testing.

To evaluate the BDI system, the research team performed diagnostic load tests on seven “typical” bridge structures: three steel-girder bridges with concrete decks, two concrete slab bridges, and two steel-girder bridges with timber decks. In addition, a steel-girder bridge with a concrete deck previously tested and modeled by BDI was investigated for model verification purposes. The tests were performed by attaching strain transducers on the bridges at critical locations to measure strains resulting from truck loading positioned at various locations on the bridge.

The field test results were used to develop and validate analytical rating models. Based on the experimental and analytical results, it was determined that bridge tests could be conducted relatively easy, that accurate models could be generated with the BDI software, and that the load ratings, in general, were greater than the ratings obtained using the codified LFD Method (according to AASHTO Standard Specifications for Highway Bridges).
# TABLE OF CONTENTS

**LIST OF FIGURES** ........................................................................................................................................... v

**LIST OF TABLES** ........................................................................................................................................... ix

**CHAPTER 1. INTRODUCTION** .......................................................................................................................... 1

1.1. Background .................................................................................................................................................. 1

1.2. Objective and Scope ..................................................................................................................................... 2

1.3. Methodology ................................................................................................................................................ 2

1.4. Report Summary ......................................................................................................................................... 3

**CHAPTER 2. LITERATURE REVIEW & SURVEY** ........................................................................................... 5

2.1. Classification of Bridges .............................................................................................................................. 5

2.2. Methods of Bridge Analysis ........................................................................................................................ 5

2.3. Bridge Rating Using Design Methods ......................................................................................................... 6

2.3.1. ASD Rating ........................................................................................................................................... 6

2.3.2. LFD Rating ........................................................................................................................................... 6

2.3.3. LRFD Rating (LRFR Method) ................................................................................................................ 6

2.4. Bridge Rating With Software Applications ................................................................................................. 7

2.4.1. ASD Rating ........................................................................................................................................... 7

2.4.2. LFD Rating ........................................................................................................................................... 8

2.4.3. LRFD Rating (LRFR Method) ................................................................................................................ 8

2.5. BDI Rating System ..................................................................................................................................... 9

2.6. Load Rating Through Physical Testing ....................................................................................................... 11

2.7. Survey of States ......................................................................................................................................... 11

**CHAPTER 3. COMPONENTS OF BDI LOAD RATING SYSTEM** ................................................................. 13

3.1. Preliminary Investigation ............................................................................................................................. 13

3.2. BDI Structural Testing System (STS) ......................................................................................................... 13

3.2.1. BDI Intelliducer .................................................................................................................................... 14

3.2.2. STS Unit ................................................................................................................................................ 15

3.2.3. Power Unit ........................................................................................................................................... 16

3.2.4. BDI Autoclicker ................................................................................................................................... 16

3.2.5. STS Software and Personal Computer ............................................................................................... 17

3.3. BDI Software Packet ................................................................................................................................ 18

3.3.1. BDI Graph Data Viewer (WinGRF) ....................................................................................................... 18

3.3.2. Model Generator (WinGEN) ............................................................................................................... 18
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1</td>
<td>Bridges in Iowa: from 2001 NBI Report</td>
<td>1</td>
</tr>
<tr>
<td>3.1</td>
<td>A BDI Intelliducer in use on top of a concrete curb</td>
<td>14</td>
</tr>
<tr>
<td>3.2</td>
<td>An Intelliducer with gage extensions in use</td>
<td>15</td>
</tr>
<tr>
<td>3.3</td>
<td>BDI STS Units in use during a load test</td>
<td>15</td>
</tr>
<tr>
<td>3.4</td>
<td>BDI Power Unit connected and ready for use</td>
<td>16</td>
</tr>
<tr>
<td>3.5</td>
<td>BDI Autoclicker in use during a load test</td>
<td>17</td>
</tr>
<tr>
<td>3.6</td>
<td>Typical screen-shots of WinGRF</td>
<td>19</td>
</tr>
<tr>
<td>3.7</td>
<td>Schematic of typical mesh generated with WinGEN</td>
<td>20</td>
</tr>
<tr>
<td>3.8</td>
<td>Typical Rating Truck Details</td>
<td>21</td>
</tr>
<tr>
<td>3.9</td>
<td>Typical screen-shots of WinGEN</td>
<td>22</td>
</tr>
<tr>
<td>3.10</td>
<td>Typical screen-shots of WinSAC</td>
<td>25</td>
</tr>
<tr>
<td>4.1</td>
<td>Cedar Creek Bridge: Photographs provided by BDI</td>
<td>28</td>
</tr>
<tr>
<td>4.2</td>
<td>Cedar Creek Bridge: Overall dimensions, gage locations, and truck paths</td>
<td>29</td>
</tr>
<tr>
<td>4.3</td>
<td>Cedar Creek Bridge: Cross-sections of the bridge</td>
<td>29</td>
</tr>
<tr>
<td>4.4</td>
<td>Cedar Creek Bridge: Girder cross-sections</td>
<td>30</td>
</tr>
<tr>
<td>4.5</td>
<td>Cedar Creek Bridge: Load Truck Details</td>
<td>31</td>
</tr>
<tr>
<td>4.6</td>
<td>Photographs of Bridge #1</td>
<td>32</td>
</tr>
<tr>
<td>4.7</td>
<td>Bridge #1: Overall bridge dimensions, gage locations, and truck paths</td>
<td>33</td>
</tr>
<tr>
<td>4.8</td>
<td>Bridge #1: Cross-sections of the bridge and individual girder</td>
<td>34</td>
</tr>
<tr>
<td>4.9</td>
<td>Bridge #1: Load Truck Details</td>
<td>34</td>
</tr>
<tr>
<td>4.10</td>
<td>Bridge #2: Photographs of the bridge</td>
<td>36</td>
</tr>
<tr>
<td>4.11</td>
<td>Bridge #2: Overall dimensions, gage locations, and truck paths</td>
<td>37</td>
</tr>
<tr>
<td>4.12</td>
<td>Bridge #2: Cross-sections of the bridge and individual girder</td>
<td>38</td>
</tr>
<tr>
<td>4.13</td>
<td>Bridge #2: Load Truck Details</td>
<td>38</td>
</tr>
<tr>
<td>4.14</td>
<td>Bridge #3: Photographs of the bridge</td>
<td>40</td>
</tr>
<tr>
<td>4.15</td>
<td>Bridge #3 Overall dimensions, gage locations, and truck paths</td>
<td>42</td>
</tr>
<tr>
<td>4.16</td>
<td>Bridge #3: Typical cross-sections of the bridge and the main girder at midspan</td>
<td>43</td>
</tr>
<tr>
<td>4.17</td>
<td>Bridge #3: Load Truck Details</td>
<td>43</td>
</tr>
<tr>
<td>4.18</td>
<td>Bridge #4: Photographs of the bridge</td>
<td>45</td>
</tr>
<tr>
<td>4.19</td>
<td>Bridge #4: Overall dimensions, gage locations, and truck paths</td>
<td>46</td>
</tr>
<tr>
<td>4.20</td>
<td>Bridge #4: Typical cross-sections of the steel beams and the bridge</td>
<td>47</td>
</tr>
<tr>
<td>4.21</td>
<td>Bridge #4: Load Truck Details</td>
<td>49</td>
</tr>
</tbody>
</table>
Figure 4.22. Bridge #5: Photographs of the bridge................................................................. 50
Figure 4.23. Bridge #5: Overall dimensions, gage locations, and truck paths...................... 52
Figure 4.24. Bridge #5: Typical cross-sections of the girders and the bridge ......................... 52
Figure 4.25. Bridge #5: Load Truck Details............................................................................. 53
Figure 4.26. Bridge #6: Photographs of the bridge............................................................... 55
Figure 4.27. Bridge #6: Overall dimensions, gage locations and truck paths........................ 56
Figure 4.28. Bridge #6: Cross-section of the bridge at midspan ........................................... 57
Figure 4.29. Bridge #6: Load Truck Details............................................................................. 57
Figure 4.30. Bridge #7: Photographs of the bridge............................................................... 58
Figure 4.31. Bridge #7: Overall dimensions and gage locations ........................................... 60
Figure 4.32. Bridge #7: Cross-section of the bridge at midspan ........................................... 60
Figure 4.33. Bridge #7: Truck path information....................................................................... 61
Figure 4.34. Bridge #7: Load Truck Details............................................................................. 62
Figure 5.1. Cedar Creek Bridge: End restraint, composite action and strain symmetry........... 64
Figure 5.2. Cedar Creek Bridge: Bridge mesh, gage locations and section property names...... 65
Figure 5.3. Cedar Creek Bridge: Typical experimental and analytical strains for load Path Y1.. 67
Figure 5.4. Cedar Creek Bridge: Truck position in sensitivity test .......................................... 68
Figure 5.5. Bridge #1: End restraint, non-composite action and strain symmetry .................. 70
Figure 5.6. Bridge #1: Bridge mesh, gage locations and section property names .................... 71
Figure 5.7. Bridge #1: Typical strain plots using Path Y1 and full truckload ......................... 72
Figure 5.8. Bridge #1: Typical strain plots at location L5 using Path Y3 ................................. 76
Figure 5.9. Bridge #2: Typical data for end restraint, non-composite action and strain symmetry .......................................................................................................................... 78
Figure 5.10. Bridge #2: Bridge mesh, gage locations and section property names .................... 79
Figure 5.11. Bridge #2: Typical strain plots for Path Y3 using optimized strains...................... 81
Figure 5.12. Bridge #2: Typical strain plots for Path Y3 using predicted strains....................... 84
Figure 5.13. Bridge #3: Experimental strains verifying end restraint and composite action....... 85
Figure 5.14. Bridge #3: Experimental strains verifying composite action and strain symmetry.... 87
Figure 5.15. Bridge #3: Mesh of analytical model and section property names........................ 88
Figure 5.16. Bridge #3: Typical strain plots on the girders for truck Path Y1 ............................. 90
Figure 5.17. Bridge #3: Typical strain plots on the stringers and floor beams ......................... 91
Figure 5.18. Bridge #4: Experimental data on the girders for Path Y1 ...................................... 95
Figure 5.19. Experimental data on a floor beam and transverse strain symmetry.................... 96
Figure 5.20. Bridge #4: Mesh of the analytical model for one half of the bridge .......................... 97
Figure 5.21. Bridge #4: Typical strains on the South girder for truck Path Y1 ............................. 98
Figure 5.22. Bridge #4: Typical strain plots for truck Paths Y1 and Y3 .................................... 99
Figure 5.23. Bridge #5: Typical experimental strains for Path Y1 ............................................... 103
Figure 5.24. Bridge #5: Typical experimental strains and symmetry plots ............................... 104
Figure 5.25. Bridge #5: Mesh of the analytical model with section property names and gage locations ................................................................................................................... 105
Figure 5.26. Bridge #5: Typical strain plots for interior girders for truck Path Y1 ..................... 107
Figure 5.27. Bridge #5: Typical strain plots for the exterior girders ......................................... 108
Figure 5.28. Bridge #6: Typical experimental strains ............................................................... 111
Figure 5.29. Bridge #6: Experimental strains and strain symmetry .......................................... 112
Figure 5.30. Bridge #6: Mesh of the analytical model with section property names ................. 113
Figure 5.31. Bridge #6: Strain plots at the West Curb for truck Path Y1 .................................... 114
Figure 5.32. Bridge #6: Typical strains on the bottom of the slab for truck Paths Y2 and Y3 .... 115
Figure 5.33. Bridge #6: Typical strain plots at the bottom of slab for truck Path Y4 ................. 116
Figure 5.34. Bridge #7: Typical experimental strains for Path Y4 ............................................... 118
Figure 5.35. Bridge #7: Experimental strains at midspan near the construction joint for Path Y2 ........................................................................................................................................... 119
Figure 5.36. Bridge #7: Experimental strains and strain symmetry verification ....................... 121
Figure 5.37. Bridge #7: Mesh of the analytical model with section property names ................. 122
Figure 5.38. Bridge #7: Strain plots on the East side of the construction joint for truck Path Y3 ........................................................................................................................................... 124
Figure 5.39. Bridge #7: Strain plots on the West side of the construction joint for truck Path Y3 ........................................................................................................................................... 125
Figure 5.40. Bridge #7: Strain plots at the East curb for truck Path Y1 ...................................... 126
Figure 5.41. Bridge #7: Strain plots at the West Curb for truck Path Y4 ...................................... 127
Figure 5.42. Bridge #7: Typical strain plots for truck Path Y2 .................................................... 128
LIST OF TABLES

Table 2.1. Model accuracies for the eight bridges analyzed by Bridge Diagnostics, Inc. .......................................................................................................................... 10

Table 3.1. Error functions and their corresponding equations ................................................................................................................................. 24

Table 5.1. Cedar Creek Bridge: Adjustable parameters ................................................................................................................................. 65

Table 5.2. Cedar Creek Bridge: Model accuracy ........................................................................................................................................ 66

Table 5.3. Cedar Creek Bridge: Stiffness parameters from Sensitivity Test when changing the location of the neutral axis for the interior girders at midspan .......... 68

Table 5.4. Cedar Creek Bridge: Maximum moments from Sensitivity Test when changing the location of the neutral axis for the interior girders at midspan .......... 69

Table 5.5. Cedar Creek Bridge: Model Accuracy from Sensitivity Test when changing the location of the neutral axis for the interior girders at midspan .......... 69

Table 5.6. Bridge #1: Adjustable parameters using full truckload (Model 1)................................................................................................................ 71

Table 5.7. Bridge #1: Model accuracy for the full truckload ................................................................................................................................. 73

Table 5.8. Bridge #1: Design Truck Ratings by the LFD Method ................................................................................................................................. 74

Table 5.9. Bridge #1: Design Truck Ratings by the BDI Software ................................................................................................................................. 74

Table 5.10. Bridge #1: Percent difference in ratings between LFD Method and BDI Software... 74

Table 5.11. Bridge #1: Adjustable parameters for all truckloads ................................................................................................................................. 75

Table 5.12. Bridge #1: Model accuracy for the half-full truckload (Model 2)................................................................................................................ 75

Table 5.13. Bridge #1: Model accuracy for the empty truck (Model 3)................................................................................................................ 75

Table 5.14. Bridge #1: Model accuracy for M1 Half and M1 Empty ................................................................................................................ 77

Table 5.15. Bridge #2: Adjustable parameters for Model 1 ................................................................................................................................. 80

Table 5.16. Bridge #2: Model accuracy for initial and optimized model (Model 1)................................................................................................................ 80

Table 5.17. Bridge #2: Design Truck Ratings by the LFD Method ................................................................................................................................. 82

Table 5.18. Bridge #2: Bridge #2: Design Truck Ratings by the BDI Software ................................................................................................................................. 82

Table 5.19. Bridge #2: Percent difference in Design Truck Ratings between LFD Method and BDI Software................................................................................................................ 82

Table 5.20. Bridge #2: Model accuracy for the optimized model including gage instrumentation for predicted strains ................................................................................................................ 83

Table 5.21. Bridge #3: Adjustable parameters ................................................................................................................................. 89

Table 5.22. Bridge #3: Section properties for non-optimized parameters ................................................................................................................................. 89

Table 5.23. Bridge #3: Model accuracy for initial and optimized model ................................................................................................................ 92

Table 5.24. Bridge #3: Design Truck Ratings by the LFD Method ................................................................................................................................. 93
Table 5.25. Bridge #3: Design Truck Ratings by the BDI Method .......................................................... 93
Table 5.26. Bridge #3: Percent difference in Design Truck Ratings between LFD Method and BDI Software .............................................................................................................. 94
Table 5.27. Bridge #4: Adjustable parameters ..................................................................................... 100
Table 5.28. Bridge #4: Model accuracy for initial and optimized model ........................................ 100
Table 5.29. Bridge #4: Design Truck Ratings by the LFD Method ..................................................... 101
Table 5.30. Bridge #4: Design Truck Ratings by the BDI Method ...................................................... 102
Table 5.31. Bridge #4: Percent difference in Design Truck Ratings between LFD Method and BDI Software .............................................................................................................. 102
Table 5.32. Bridge #5: Adjustable parameters ..................................................................................... 105
Table 5.33. Bridge #5: Model accuracy for initial and optimized model ........................................ 106
Table 5.34. Bridge #5: Design Truck Ratings by the LFD Method ..................................................... 109
Table 5.35. Bridge #5: Design Truck Ratings by the BDI Method ...................................................... 109
Table 5.36. Bridge #5: Percent difference in Design Truck Ratings between LFD Method and BDI Software .............................................................................................................. 109
Table 5.37. Bridge #6: Adjustable parameters ..................................................................................... 110
Table 5.38. Bridge #6: Model accuracy for initial and optimized model ........................................ 117
Table 5.39. Bridge #6: Design Truck Ratings by the LFD Method ..................................................... 118
Table 5.40. Bridge #6: Design Truck Ratings by the BDI Method ...................................................... 118
Table 5.41. Bridge #6: Percent difference in Design Truck Ratings between LFD Method and BDI Software .............................................................................................................. 118
Table 5.42. Bridge #7: Adjustable parameters ..................................................................................... 123
Table 5.43. Bridge #7: Model accuracy for initial and optimized model ........................................ 123
Table 5.44. Bridge #7: Design Truck Ratings by the LFD Method ..................................................... 129
Table 5.45. Bridge #7: Design Truck Ratings by the BDI Method ...................................................... 130
Table 5.46. Bridge #7: Percent difference in Design Truck Ratings between LFD Method and BDI Software .............................................................................................................. 130
1. INTRODUCTION

1.1. BACKGROUND

The 2001 Iowa National Bridge Inventory (NBI) Report (11) indicated that of the 25,138 bridges in Iowa, 7,102 (29%) are either structurally deficient or functionally obsolete. While many of these bridges may be strengthened or rehabilitated, some simply need to be replaced. Before implementing one of these options, one should consider performing a diagnostic load test on the structure to more accurately assess its load carrying capacity. Frequently, diagnostic load tests reveal strength and serviceability characteristics that exceed the predicted codified parameters. Usually, the codified parameters are conservative when predicting the load distribution characteristics and the influence of other structural attributes; hence the predicted rating factors are often conservative. In cases where calculations show a structural deficiency, it may be very beneficial to apply a tool that utilizes a more accurate model that incorporates field-test data; at a minimum, this approach would result in more accurate load ratings and frequently results in increased rating factors. Bridge Diagnostics, Inc. (BDI) developed hardware and software that is specially designed for performing bridge-ratings based on data from physical testing. The hardware consists of pre-wired strain gages, a data acquisition system, and other components. The software consists of three separate programs for visually evaluating test data, developing an analytical model, analyzing and calibrating the model, and performing load-rating calculations with the calibrated model. Figure 1.1 illustrates the bridges in Iowa from the 2001 NBI Report (12).

Figure 1.1. Bridges in Iowa: from 2001 NBI Report (11).
1.2. OBJECTIVE AND SCOPE

The objective of the work presented herein was to investigate the useability of the BDI structural testing system for bridge load rating based on physical testing. The project includes examination of all aspects of the system including:

- Instrumentation installation.
- Data collection.
- Data interpretation.
- Analytical model verification, generation, calibration, and load rating.
- Comparison with codified load rating using the Load Factor Design (LFD) Method.

Seven different “typical” bridge structures were selected and investigated to reach the objective. The bridges included three steel-girder bridges with concrete decks, two concrete slab bridges, and two steel-girder bridges with timber decks. In addition, a steel-girder bridge with a concrete deck previously tested and modeled by BDI was investigated for model verification purposes. This report will focus primarily on bridge descriptions, equipment installation, describing the analytical process, including analytical model verification, generation, calibration, analytical load rating, and codified load rating.

1.3. METHODOLOGY

The methods used in this report include a complete investigative process, which is described below:

- Model verification includes comparing previously calculated parameters with new model parameters in order to verify that the calibration process is acceptable and accurate.
- Model generation includes creating an analytical bridge model using the BDI Software.
- Model calibration includes using the measured field strains and the analytical model to adjust model parameters such that the difference between field and analytical strain data is minimized.
- Analytical load rating includes applying appropriate design trucks to the calibrated model in order to extract loads and obtain rating factors for the bridge sections of interest.
- Codified load rating includes applying appropriate design truckloads on the bridge as stated in AASHTO Standard Specifications (4).
1.4. REPORT SUMMARY

This report is divided into six chapters; Chp. 1 provides the background information, objective and scope, methodology, and report summary. The literature review for evaluation of the BDI and other rating methods, and a description of the different design methods available is presented in Chp. 2. A description of the BDI system is given in Chp. 3. Chapter 4 provides descriptions of all seven tested bridges in addition to the bridge used for model verification, and Chp. 5 summarizes the results for all eight bridges. Finally, Chp. 6 provides conclusions and recommendations.
2. LITERATURE REVIEW & SURVEY

A literature search was performed to collect information on rating methods and bridge analysis methods. The Structural Information Service Center in the Iowa State University Bridge Engineering Center was searched first. In addition, several computerized searches were conducted through the Iowa State University Parks Library. A summary of representative literature is presented which focuses on issues relating to this investigation.

2.1. CLASSIFICATION OF BRIDGES

In bridge engineering, it is common practice to classify bridges into three broad groups, which are short-span, medium-span, and long-span bridges. Currently, no established criteria define the span ranges, but a common practice to classify bridges by span length are as follows:

- Short-span bridges: 20-125 ft
- Medium-span bridges: 125-400 ft
- Long-span bridges: Over 400 ft

Bridges with spans less or equal to 20 ft are classified as culverts. Bridges can also be classified according to materials (concrete, steel, or wood), usage (pedestrian, highway, or railroad), or structural form (slab, girder, truss, arch, suspension, or cable-stayed). All bridges investigated in this study are, by applying the criteria noted, defined as short-span highway bridges.

2.2. METHODS OF BRIDGE ANALYSIS

According to Xanthakos (14), for the purpose of elastic analysis, steel beam bridge systems may be classified into (a) orthotropic plate concepts that consider the bridge system as an elastic continuum to be treated as an equivalent plate; (b) grid systems concepts that idealize the bridge system as an equivalent grillage of interconnected longitudinal and transverse beams, cross-members, and diaphragms; and (c) girder-plate concepts where the interacting forces between the slab and longitudinal girders are treated as the redundants of the system. Examples of inelastic behavior can be found in composite bridge systems, so classical force and displacement methods that are based on elastic behavior need to be supplemented or replaced by finite-difference and finite-element techniques, folded plate methods, finite strip methods, grillage analogy, series or other harmonic methods, and yield line theories.
2.3. DESIGN METHODS

The American Association of State Highway and Transportation Officials (AASHTO) Standard Specifications (4) allows two alternative design procedures: Allowable Stress Design (ASD) and strength design method (or load factor design (LFD)). In addition, bridge engineers also have a choice of using the newly adopted AASHTO Load and Resistance Factor Design (LRFD) Specifications (2) as a new standard.

2.3.1. Allowable Stress Design (ASD) Method

The ASD Method is a service level design method and historically has been the standard design method for most structures. The method proportions structural members using design loads and forces, allowable stresses, and design limitations for the material of interest under service conditions. For example, for structures composed of steel girders with concrete slabs connected by shear connectors, the composite girders and slabs shall be designed and the stresses computed by the composite moment of inertia method and shall be consistent with the predetermined properties of the various materials. The ASD method implies that the ultimate limit state is automatically satisfied if allowable stresses are not exceeded.

2.3.2. Load Factor Design (LFD) Method

LFD Method is an alternative method for the design of simple and continuous beam and girder structures of moderate length. It is a limit states design with emphasis on ultimate limit states, with the serviceability limit states typically checked for compliance. The required strength of a section is the strength necessary to resist the factored loads and forces applied to the structure in the combinations stipulated by the AASHTO Standard Specifications (4). The “design strength” refers to the factored resistance, $\phi R_u$, whereas “required strength” refers to the load effects computed from factored loads. The resistance factor “$\phi$” depends on the type of the load effects (e.g., flexure, shear, torsion, etc.) and on the special characteristics of the loaded member (e.g., reinforced concrete, prestressed concrete, precast, cast-in-place, etc.).

2.3.3. Load and Resistance Factor Design (LRFD) Method

The basic LRFD Methodology is that each component and connection must satisfy a modified version of the LFD Methodology. Each component and connection shall satisfy Equation 2-1 for each limit state, unless otherwise specified. For service and extreme event limit
states, resistance factors shall be taken as 1.0. All limit states shall be considered of equal importance. Accordingly, as illustrated in AASHTO LRFD Specifications (2),

\[ n \times \sum \mu_i \times Q_i < \phi \times R_n = R_f \]  

(2-1)

where:
- \( n \) = \( n_D \times n_R \times n_i > 0.95 \)
- \( \mu \) = load factor (statistically based multiplier applied to force effects)
- \( \phi \) = resistance factor (statistically based multiplier applied to nominal resistance)
- \( n_D \) = factor relating to ductility
- \( n_R \) = factor relating to redundancy
- \( n_i \) = factor relating to operational importance
- \( Q_i \) = force effect (deformation or stress, i.e., thruss, shear, torque, or moment caused by applied loads, imposed deformations, or volumetric changes)
- \( R_n \) = nominal resistance (based on permissible stresses, deformations, or specified strength of materials)
- \( R_f \) = factored resistance = \( \phi \times R_n \)

2.4. BRIDGE RATING USING DESIGN METHODS

This section describes methods currently used for bridge rating, which include the ASD Rating Method, the LFD Rating Method, and the Load and Resistance Factor Rating (LRFR) Method. Although these methods are described in the following sections, only the LFD Method has been utilized in this report since it is most similar to the BDI approach. An important objective of this investigation was to compare the rating values obtained from theoretical methods with those obtained utilizing the software, which uses field load test data. Therefore, it was desired to apply the same methodology so that the rating values can be realistically compared.

2.4.1. ASD Rating

According to AASHTO Standard Specifications (4), since the ASD Rating utilizes stresses, the rating equation is as shown in Equation 2-2:

\[ RF = \frac{f_S - f_{DL}}{f_{LL-1}} \]  

(2-2)

where:
- \( RF \) = Rating Factor
- \( f_s \) = Allowable stress
\[ f_{DL} = \text{Stresses due to dead load} \]
\[ f_{LL\_I} = \text{Stresses due to live load plus impact} \]

### 2.4.2. LFD Rating

Since the LFD Rating utilizes loads, according to AASHTO Specifications (4), the rating equation is as shown in Equation 2-3:

\[
RF = \frac{C - 1.3 \times DL}{2.17 \times LL \times (1 + I)}
\]  
(2-3)

where:
- \( RF \) = Rating Factor
- \( C \) = Capacity of section of interest
- \( DL \) = Dead Load
- \( LL \) = Live Load
- \( I \) = Impact coefficient

### 2.4.3. LRFD Rating (LRFR Method)

The LRFR Method utilizes stresses, but applies more factors in the rating equation. According to AASHTO LRFD Specifications (2), the LRFR Rating equation is as follows:

\[
RF = \frac{C - \gamma_{DC} \times DC - \gamma_{DW} \times DW + \gamma_{P} \times P}{\gamma_{L} \times L \times (1 + IM)}
\]  
(2-4)

The capacity when utilizing the Strength Limit States is shown in Equation 2-5:

\[
C = \phi_{C} \times \phi_{S} \times \phi \times R
\]  
(2-5)

And the capacity when utilizing the Service Limit States is shown in Equation 2-6:

\[
C = f_{R}
\]  
(2-6)

where:
- \( RF \) = Rating Factor
- \( \phi_{C} \) = Condition factor
- \( \phi_{S} \) = System factor
- \( \phi \) = LRFD Resistance factor
- \( R \) = Nominal member resistance
- \( C \) = Capacity
- \( f_{R} \) = Allowable stress
$\gamma_{DC} = \text{LRFD Load factor for structural components and attachments}$

$DC = \text{Dead load effect due to structural components and attachments}$

$\gamma_{DW} = \text{LRFD Load factor for wearing surfaces and utilities}$

$DW = \text{Dead load effect due to wearing surfaces and utilities}$

$\gamma_P = \text{LRFD Load factor for permanent loads other than dead loads}$

$P = \text{Permanent loads other than dead loads}$

$\gamma_L = \text{Evaluation live load factor}$

$L = \text{Live load effect}$

$IM = \text{Dynamic load allowance}$

### 2.5. BDI RATING SYSTEM

Although there are other bridge-rating software packages available, only the BDI Software, which was used throughout this investigation, is described in this section. The BDI Software applies the limit states for rating calculations by using the loads applied to the structure. The rating equation used by the BDI Software is of the same general format as the LFD Method; however, the user must specify the load factors as illustrated in Equation 2-7:

$$RF = \frac{C - \gamma_{DL} \times DL}{\gamma_{LL} \times LL \times (1 + I)}$$

where:

$RF = \text{Rating Factor}$

$C = \text{Capacity}$

$\gamma_{DL} = \text{Dead Load Factor}$

$\gamma_{LL} = \text{Live Load Factor}$

$I = \text{Impact coefficient}$

In 1999, the Iowa Department of Transportation (Iowa DOT) contracted the BDI (9) team to test and rate eight highway bridges. The final report of that work was presented to the Iowa DOT in November 1999 as “Load Testing and Load Rating Eight State Highway Bridges in Iowa.” Four of these bridges were three-span reinforced concrete slab bridges, two with a 17-degree skew and two with no skew. Also tested and rated were a single span and a three span steel-girder/reinforced-concrete deck bridge, a three span parabolic reinforced-concrete T-beam bridge, and a single span prestressed-concrete/steel-girder hybrid bridge. Based on the codified approach, all but one of the
eight bridges has an Inventory Rating for an HS-20 truck below 1.0, while, based on the BDI approach, only one of the bridges has an Inventory Rating for an HS-20 truck below 1.0.

For the HS-20 load vehicle, the BDI approach yielded higher rating factors than the codified approach. The four reinforced concrete slab bridges had Inventory Ratings increases that varied from 4 to 103 percent with Inventory Rating factors greater than the codified factors by an average of 70 percent. The two steel bridges tested had Inventory Rating factors that were 146-158 percent greater than the codified factors. The prestressed concrete/steel hybrid bridge and the parabolic reinforced concrete T-beam bridge had ratings that were more than 350 percent greater. Much of the rating increases were credited to issues such as increased exterior beam stiffness due to the presence of reinforced concrete parapets and the presence of unintended composite action.

The model accuracy results for the eight bridges are given in Table 2.1. These results illustrate that, in general, the concrete slab bridges (bridges BDI-1, BDI-2, BDI-3, BDI-5 and BDI-8) are more difficult to model than the steel girder bridges (bridges BDI-4, BDI-6 and BDI-7).

Table 2.1. Model accuracies for the eight bridges analyzed by Bridge Diagnostics, Inc.

<table>
<thead>
<tr>
<th>Bridge</th>
<th>Total error</th>
<th>Percent error</th>
<th>Scale error</th>
<th>Correlation Coefficient</th>
</tr>
</thead>
<tbody>
<tr>
<td>BDI-1</td>
<td>943</td>
<td>13.0</td>
<td>4.1</td>
<td>0.95</td>
</tr>
<tr>
<td>BDI-2</td>
<td>1,570</td>
<td>9.5</td>
<td>4.1</td>
<td>0.95</td>
</tr>
<tr>
<td>BDI-3</td>
<td>1,028</td>
<td>4.4</td>
<td>3.0</td>
<td>0.98</td>
</tr>
<tr>
<td>BDI-4</td>
<td>911</td>
<td>6.0</td>
<td>4.2</td>
<td>0.97</td>
</tr>
<tr>
<td>BDI-5</td>
<td>2,366</td>
<td>15.5</td>
<td>5.3</td>
<td>0.93</td>
</tr>
<tr>
<td>BDI-6</td>
<td>2,546</td>
<td>2.0</td>
<td>3.2</td>
<td>0.99</td>
</tr>
<tr>
<td>BDI-7</td>
<td>1,601</td>
<td>3.4</td>
<td>3.5</td>
<td>0.98</td>
</tr>
<tr>
<td>BDI-8</td>
<td>1,258</td>
<td>2.5</td>
<td>1.7</td>
<td>0.99</td>
</tr>
</tbody>
</table>

where:  
BDI-1, BDI-2, BDI-3, BDI-5 are three span reinforced concrete bridges.  
BDI-4 is a single span steel girder bridge with a concrete deck.  
BDI-6 is a three span steel girder bridge with a concrete deck.  
BDI-7 is a single span steel girder and prestressed concrete beams bridge with a concrete deck.  
BDI-8 is a three span parabolic reinforced concrete T-beam bridge.

4 Total strain difference in microstrain.  
5 Sum of the strain differences squared divided by the sum of the measured strains squared.  
6 Maximum error from each gage divided by the maximum strain from each gage.  
7 Represents how well the shapes of the computed response histories match the measured response.
The parameters given in Table 2.1 are defined as follows: the total error (a), the percent error (b), the scale error (c), and the correlation coefficient (d). The correlation coefficient value can vary between –1.0 and 1.0 where 1.0 represents an exact linear relationship and –1.0 represents an exact opposite linear relationship. The equations used to calculate these parameters are described in Chp. 3.

2.6. LOAD RATING THROUGH PHYSICAL TESTING

In 1998, Lichtenstein (10) authored the “Manual for Bridge Rating Through Load Testing” through an National Cooperative Highway Research Program (NCHRP) project as a guide for the nondestructive load testing of bridges for improved rating. This report focused on defining and illustrating nondestructive load testing and its applications to the rating community. There are two types of nondestructive load testing described by Lichtenstein for the purpose of bridge load rating: diagnostic and proof. Diagnostic load testing involves loading the bridge in question with a known truck load at set positions and measuring the bridge response. The results of a diagnostic test would typically be used to facilitate rating calculations. Proof load testing involves setting a limit or goal for the bridge and gradually increasing the vehicle load until the limit or goal is reached. Both types of load tests can yield knowledge of a particular structure’s behavior and can be used to generate more accurate load ratings. Lichtenstein notes that most bridge types can benefit from testing.

2.7. SURVEY OF STATES

To gain a better understanding of how bridge owners are using physical testing as a tool to better manage their bridge inventory, a survey of State DOT’s and Iowa County Engineers was conducted. A copy of the questionnaire sent to State DOT’s, which includes 8 questions is presented in Appendix A. The county survey, which includes 3 questions, is given in Appendix B.

Of the 36 survey respondents, 10 responded to the state questionnaire, and 26 responded to the county questionnaire. Based on the relatively low response rate, only general conclusions drawn from the responses can be made. Most respondents do not perform physical testing for load rating purposes, and responded that, in general, such testing is not conducted due to lack of specific procedures, unfamiliarity with various non-destructive techniques, believed to not be cost effective, or current comfort with the typical AASHTO rating results. Also, when asked how much would be budgeted for a physical load test, analysis, and rating for a given hypothetical bridge, most participants responded “Less than $5,000”. However, it is interesting to note that most respondents that do perform load testing for rating purposes, indicated “More than $15,000” when asked the same
question. Based on these results, there is reason to believe that those who do not perform load testing for rating purposes assume that it is not economically feasible, while those who perform load testing have found it to be economically viable for evaluating bridge conditions. It was also found that most respondents that perform load testing for rating purposes consider edge rail stiffening and restraint at the abutments or piers when calculating ratings.
3. COMPONENTS OF BDI LOAD RATING SYSTEM

The system developed by BDI is a systematic approach to the testing, modeling, and rating of bridges. The system, which has three basic phases each with their own tools and individual processes, is described in the following sections. A step-by-step procedure for completing an analysis and rating is given in Appendix C.

3.1. PRELIMINARY INVESTIGATION

The first step is to perform a preliminary investigation of the bridge, which includes a visual inspection of the bridge. It is important to observe anything out of the ordinary that can influence the bridge behavior, such as concrete deterioration, beam deformations, large cracks in the slab, support conditions, etc. In addition, if possible, previous maintenance and inspection reports should also be reviewed.

Based on information collected during the preliminary investigation, an instrumentation plan is developed. This plan, which uses the components described in the following sections, is established to gain a better understanding of the bridge behavior (e.g., end restraint, edge stiffening, composite action, load distribution, etc.).

3.2. BDI STRUCTURAL TESTING SYSTEM (STS)

The Structural Testing System (STS) is the field component of the testing system, and consists of four main elements: the BDI Intelliducers, the BDI STS Units, the BDI Autoclicker, and the BDI Power Unit. The main purpose of using the STS is to collect bridge behavior data. Specifically, collecting strain data as a truck with known dimensions and weight is driven over the bridge. It is common to position the truck in at least three different transverse positions: the outer wheel line placed at two feet from each curb and the truck centered on the bridge. Additional positions may also be included if needed. Typically, the truck will be driven in each lane twice to verify that the recorded strains are consistent. If any strain asymmetry is determined (by comparing data from symmetric load paths), the analytical model must be developed accordingly.

3.2.1. BDI Intelliducer

The BDI Intelliducer, shown in Fig. 3.1, is the strain transducer used with the BDI system for measuring bridge response. Each Intelliducer measures 4.4 in. x 1.2 in. x 0.4 in., with either a 15-ft or 25-ft wire attached and has the ability to identify itself to the rest of the system with a unique number.
(i.e., 4696, 4788, etc.) that can be identified and recognized by the STS power unit (described subsequently). From this unique number, the system has the ability to calibrate and zero the gage using a pre-stored gage calibration factor. Intelliducers may be used on many different surfaces, including, but not limited to, steel, concrete (reinforced and pre-stressed), and timber. This wide variety of uses stems from the design and the ease of application of the transducers. Two holes (3 in. on center) in the transducer are for the ‘tabs’, which are bonded to the testing surface using Lactic adhesive after appropriately preparing the surface of the element being tested.

Figure 3.1. A BDI Intelliducer in use on top of a concrete curb.

For gage placement on reinforced concrete structures, gage extensions should be implemented (see Fig. 3.2) to increase the 3-inch gage length; the longer length enables surface strains to be averaged over a greater distance, thus reducing the effects of cracks in the concrete. BDI has prescribed a set of standards for the use of gage extensions. A gage length of $1.0 \times d$, where $d$ is the member depth, and $L/20$, where $L$ is the span length, are given as lower and upper bounds, respectively, for reinforced concrete slabs and rectangular beams. For T-beams, the lower and upper bounds are given as $1.5 \times d$ and $L/20$, respectively.
3.2.2. STS Unit

The BDI STS Unit, shown in Fig. 3.3, transfers the data collected from the Intelliducers to the Power Unit (described in the following section). Each STS Unit is capable of collecting data from four Intelliducers. An STS Unit has the capability of storing 50,000 data points during a single test. At the conclusion of a test, the data are transferred to the Power Unit (described subsequently).
Each STS Unit measures 2.3 in. x 3.0 in. x 11.0 in. and weighs 1.8 lbs. The unit is equipped with six connection points, four transducer connections, a “line out”, and a “line in”. All of the connections are quick-lock, military-style. The “line out” or P/C end of the unit transmits data to the Power Unit and P/C. The “line in” connection is designed to attach to other units in series and/or parallel through the use of Y-cables. This wiring configuration is a significant advantage over traditional transducer wiring in that only a single cable is connected to the Power Unit.

3.2.3. Power Unit

The Power Unit, shown in Fig. 3.4, powers the intelliducers and transmits commands to the system during the test. Each transducer requires a 5-volt excitation voltage that is provided by the Power Unit. The unit has the ability to operate under two different energy sources, DC current from an automobile battery or AC current from a small portable generator or inverter.

![Figure 3.4. BDI Power Unit connected and ready for use.](image)

3.2.4. BDI Autoclicker

The BDI Autoclicker, shown in Fig. 3.5, measures and transmits the load vehicle position to the Power Unit through the use an electronic eye and hand-held radio transmitters. A reflective strip placed on the load vehicle’s tire triggers the electronic eye. Thus, every wheel revolution creates a “click” in the data. These “clicks” are used to correlate data collected in the time domain to the truck position domain. For bridges that have a very short span as compared to a wheel revolution, the clicks
may be recorded by hand by simply removing the Autoclicker radio and tapping the transmit button at regularly spaced intervals.

Figure 3.5. BDI Autoclicker in use during a load test.

3.2.5. STS Software and Personal Computer

The control functions of the system are performed by the STS software. The software is run in a Microsoft Windows environment on a laptop computer that is attached, via a parallel port, to the Power Unit. The system is relatively easy to use with pull down menus and large command buttons. The initial setup of the software should only be completed after all connections between Intelliducers, STS Units, and the Power Unit have been completed. The initial setup verifies that all Intelliducers are recognized by the rest of the system and that all connections are tight.

The main software menu window contains most of the information that is critical to the load test. Items such as sample frequency, test length, and file output name are easily accessible in the main window. Other options specifically related to Intelliducers such as channel gain, initial offset, and filtering are located in the advanced options menu. Careful attention should be given to these settings to ensure proper data collection.
3.3. BDI SOFTWARE PACKET

The BDI Software Packet is the analytical modeling part of the testing system, and consists of three main components: WinGRF – data presentation, WinGEN - model generator, and WinSAC - structural analysis and correlation. All elements serve different purposes, but each is essential to the overall process. Each component has been developed such that data can be seamlessly moved from one application to another. These three components are described in detail in the following sections.

3.3.1. BDI Graph Data Viewer (WinGRF)

WinGRF is used for graphical data presentation, and is the first step in the modeling process. First, the “clicker distance” – the known distance (e.g., wheel circumference) used to convert data from the time domain into the truck position domain – must be input in the field strain files. Plots can then be viewed in terms of truck position to observe bridge behavior information, such as the presence of end restraint conditions, non-symmetric behavior, etc. Plots, such as neutral axis location, may also be constructed if the distance between a pair of top and bottom gages has been input in the program. Options, such as averaging and filtering of data files and offset correction, may also be completed in WinGRF. Figure 3.6 shows typical screen shots of WinGRF; an example of strain plots is shown in Fig. 3.6a while an example of a neutral axis plot is presented in Fig. 3.6b.

3.3.2. Model Generator (WinGEN)

WinGEN is a finite element model generator. This application allows the user to create models using beam and shell elements. A 2-D model can be created using the WinGEN; however, it is also possible to create a 3-D model using a commercial drafting program, such as AutoCAD, which is then imported into WinGEN. A sketch of a typical model is presented in Fig. 3.7.

Once the overall model is defined and all section and material properties have been entered, the location of intelliducers used in the field test can be established on the sections (both beam and deck). Through this, direct comparisons between the field data and analytical results can be made. A common source of error in bridge modeling is to implement incorrect boundary conditions. WinGEN allows the use to establish constraint conditions at the abutments and at the piers (if any) that represent the actual conditions. To make comparisons between the field strains and the analytical strains, an idealized truck simulating the truck used during the field test can be created. When necessary, model optimization parameters are also established using WinGEN.
Figure 3.6. Typical screen-shots of WinGRF.
Figure 3.7. Schematic of typical mesh generated with WinGEN.

After an accurate model has been created (through appropriate optimization), rating trucks, such as HS-20, HS-20 (30), H-20 or Type-3 (shown in Fig. 3.8), are idealized with appropriate critical load paths to induce maximum live load. Capacities, typically calculated according to AASHTO Standard Specifications (4), are input into WinGEN. Next one needs only to compute the loads on the desired sections by applying dead load and live load from the rating trucks and associated paths, on the structure. Typical screen shots from WinGEN are shown in Fig. 3.9.
Figure 3.8. Typical Rating Truck Details.
a. Plan view of analytical model.


Figure 3.9. Typical screen-shots of WinGEN.
3.3.3. **Structural Analysis and Correlation (WinSAC)**

After a model has been created in WinGEN, the WinGEN output file will be used in WinSAC. WinSAC performs analytical calculations and also constructs iterative analytical solutions by changing user defined optimization parameters within user defined boundaries. The resulting model, in the best way possible, represents the actual bridge behavior given user entered constraints. Typical variables chosen as optimization parameters are beam moments of inertia, modulus of elasticity of slabs, and rotational restraint at the abutments. The user sets the appropriate boundaries, so that the final optimized variables are within reasonable values. Usually, the lower limit for moment of inertias are set to 80 % of the non-composite value of the sections, and the upper limit set to 120 % of the composite values. Typically, there is no lower limit for the moment of elasticity for the slabs, but the upper limit may vary depending on the type of slab. The rotational restraints do not need explicit boundaries since zero represents a simply supported condition and infinity represents a fixed condition. Analytical accuracy is reported in terms of total error, percent error, percent scale error, and correlation coefficient, where the definitions of these variables have been discussed in Chp. 2. Equations for calculating the error functions where \( m \) represents measured strains, \( c \) represents calculated strains, and \( n \) represents the total number of strain computations are given in Table 3.1. In WinSAC, the percent error is considered to be the optimization objective function.

As mentioned previously, WinSAC performs multiple iterations, which includes a statistical analysis of the model where analytical strains are compared to the measured strains. Each iteration consists of \( N \) sub-iterations where \( N \) is the number of user-defined optimization parameters. Basically, WinSAC changes one optimization parameter per sub-iteration within the user-defined boundaries to establish the model accuracy sensitivity for that particular parameter. After all sub-iterations are completed and the model accuracies for all parameters have been established, WinSAC optimizes all parameters accordingly, and a new iteration begins, with updated section parameters. These iteration-loops (i.e., iterations and sub-iterations) continue until the percent error cannot be improved, and the optimization process is terminated with the percent error from the final iteration as the “lowest” error. The section parameters from the last iteration represent the optimized model. A “good” model will generally have a correlation coefficient greater than 0.90 and a percent error less than 10%. WinSAC results may be plotted with experimental results using WinGRF for a visual illustration of the model accuracy. Typical screen shots of WinSAC that illustrate the run time options and the iterations are shown in Fig. 3.10.
Table 3.1. Error functions and their corresponding equations.

<table>
<thead>
<tr>
<th>Error Function</th>
<th>Equation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Absolute Error</td>
<td>$\sum_{n}</td>
</tr>
<tr>
<td></td>
<td>$\sum_{n} (e_m - e_c)^2$</td>
</tr>
<tr>
<td>Percent Error</td>
<td>$\frac{\sum_{n} e_m^2}{\sum_{n} e_m^2}$</td>
</tr>
<tr>
<td></td>
<td>$\max \sum_{n}</td>
</tr>
<tr>
<td>Scale Error</td>
<td>$\frac{\max \sum_{n}</td>
</tr>
<tr>
<td></td>
<td>$\sum_{n} e_m - \text{average}(e_m) \cdot (e_c - \text{average}(e_c))$</td>
</tr>
<tr>
<td>Correlation Coefficient</td>
<td>$\frac{\sum_{n} (e_m - \text{average}(e_m))(e_c - \text{average}(e_c))}{\sum_{n} (e_m - \text{average}(e_m))^2 \cdot (e_c - \text{average}(e_c))^2}$</td>
</tr>
</tbody>
</table>

* See Manual (*)
a. Run time options.

b. Computer iterations showing adjustable parameters and model accuracy.

Figure 3.10. Typical screen-shots of WinSAC.
4. BRIDGE DESCRIPTION AND EXPERIMENTAL PROGRAM

To complete the requirements of this project, seven bridges were tested, analyzed, and rated for purposes of evaluating the applicability and use of the BDI system. In addition, a bridge that had been previously tested and analyzed, was modeled to verify the procedures used herein. The following sections describe the bridges and the experimental program followed.

4.1. CEDAR CREEK BRIDGE: MODEL VERIFICATION

In an attempt to verify that the modeling process used herein was correct, data files and geometric information from a bridge previously investigated by BDI were used to generate analysis results. These results were then compared with results generated by BDI. The bridge used in this verification was Bridge 7601.2S003, a simple-span, composite steel-girder bridge with no skew carrying IA3 over Cedar Creek in Pocahontas County, IA. Based on photographic documentation provided by BDI (see Fig. 4.1) all elements of this bridge appear to be in good condition. As can be seen in Fig. 4.1b, it was anticipated that the bridge would exhibit significant end restraint as the beams appear to be integral with the abutments. This bridge, shown in plan view in Fig. 4.2 and in cross-section in Fig. 4.3, has a span length of 41 ft – 3 in. from centerline to centerline of bearings with a roadway width of 30 ft and an overall width of 32 ft (two 12 ft traffic lanes and two 3 ft shoulders). For reference, BDI submitted the results for this bridge in a report entitled “Load Testing and Load Rating Eight State Highway Bridges in Iowa” to the Iowa Department of Transportation in November 1999 (9).

The deck consists of a Portland Cement (P.C.) overlay and a reinforced concrete-slab deck slightly arched in a parabolic curve with an average thickness of 8.29 in. The superstructure is comprised of two exterior and two interior girders (primary members) and two diaphragm lines (secondary members). The substructure is a reinforced concrete abutment with fixed steel bearings and a reinforced-concrete backwall (shown in Fig. 4.1b). The exterior girders (shown in Figs. 4.4a and 4.4b) consist of two different sections. Over the center 26 ft – 11 in. there is an angle bolted to the outside of the web and a cover-plate welded to the bottom flange. The interior girders (shown in Figs. 4.4c and 4.4d) also consist of two different sections; the section at midspan includes a 26 ft – 11 in. long cover-plate. All girders were instrumented at sections 2 ft from the abutment centerline and at midspan as shown in Fig. 4.2. Each instrumented section had a gage installed on the bottom surface of the top and bottom flanges as shown in Fig. 4.4 (six gages were installed on each girder for a total of 24 gages on the bridge).
A loaded tandem-axle dump truck with a total weight of 50.72 k was used in the tests. Details for the load truck are given in Fig. 4.5. Data were collected for the two truck paths shown in Fig. 4.2 with two runs conducted for each path. Path Y1 was oriented such that the driver’s side wheel line was 11 ft – 5 in. from the South girder, while path Y2 had the driver’s side wheel line 25 ft – 3 in. from the South girder.

Figure 4.1. Cedar Creek Bridge: Photographs provided by BDI.

a. Exterior beam at midspan.

b. Abutment.
Figure 4.2. Cedar Creek Bridge: Overall dimensions, gage locations, and truck paths.

Figure 4.3. Cedar Creek Bridge: Cross-sections of the bridge.

a. Cross-section near abutment.

b. Cross-section at midspan.
a. Exterior girder near abutment.  
b. Exterior girder at midspan.  
c. Interior girder near abutment.  
d. Interior girder at midspan.

Figure 4.4. Cedar Creek Bridge: Girder cross-sections.
4.2. **BRIDGE #1**

Bridge #1, Boone County Bridge #99, located in western Boone County, IA, is a non-composite, simple-span, steel-girder bridge with a timber deck and no skew carrying 230th Street over a small stream (half a mile East of D. Ave.). Based on a cursory visual inspection and photographic documentation (shown in Fig. 4.6), all steel-girders and the timber deck appear to be in good condition. As can be seen in Fig. 4.6a, it was anticipated that the bridge would not exhibit significant end restraint as the beams are not integral with the abutments. This bridge, shown in plan view in Fig. 4.7 and in cross-section in Fig. 4.8, has a span length of 44 ft – 8 in. from centerline to centerline of abutment bearings with a roadway width of 19 ft and an overall width of 19 ft – 8 in. (one 12 ft traffic lane and two 3 ft – 6 in. shoulders).

The timber deck consists of a 4-in. thick wood plank system with a 1-in. asphalt overlay without structural connection to the girders. In addition, there is a 3-in. gravel overlay on top of the asphalt. The superstructure is comprised of eight girders and four lines of diaphragms bolted to the girders. The substructure consists of expansion bearings and timber backwalls. The exterior beams and the six interior beams are the same size and are spaced on 2 ft – 6.25 in. centers. Six of the eight girders were instrumented near the East abutment and at midspan as shown in Fig. 4.7b. Each instrumented section had a gage installed on the bottom surface of the top and bottom flanges as previously described for Cedar Creek Bridge (shown in Fig. 4.4), thus, a total of 24 gages were installed at 12 locations.
A loaded tandem-axle dump truck with a total weight of 49.58 k was used in the tests. Details of the truck are given in Fig. 4.9. Data were collected for three truck paths with two runs conducted for each path. Path Y1 was oriented such that the driver’s side wheel line was 8 ft – 10 in. from the South girder (with the outer wheel line placed 2 ft from the centerline of the South girder), and path Y2 positioned the truck approximately over the center of the bridge with the driver’s side wheel line 12 ft – 8 in. from the South girder. Finally, path Y3 was oriented with the driver’s side wheel line 15 ft – 6 in. from the South girder (the outer wheel line was placed 2 ft from the North girder). Truck path information and gage locations are presented in Fig. 4.7.

Figure 4.6. Photographs of Bridge #1.

a. Abutment.

b. Girders and the West side of abutment.

c. End view of bridge.
a. Overall dimensions and truck paths Y2 and Y3.

b. Truck path Y3 and gage locations.

Figure 4.7. Bridge #1: Overall bridge dimensions, gage locations, and truck paths.
a. Cross-section of the bridge.

b. Cross-section of a girder.

Figure 4.8. Bridge #1: Cross-sections of the bridge and individual girder.

Total Weight = 49.58 k

Figure 4.9. Bridge #1: Load Truck Details.
4.3.  BRIDGE #2

Bridge #2, Boone County Bridge #11, located in northern Boone County, IA, is a non-composite, simple-span, steel-girder bridge with a timber deck and no skew carrying L Rd. over a small stream one mile North of 130th Street. Based on a cursory visual inspection and photographic documentation, all steel-girders except one appeared to be, with the exception of some light rust, in good condition. The girder on the far West side was bent at midspan (possibly hit by a large object during a flood). The timber deck is in good condition. Photographs of the bridge including the damaged girder are illustrated in Fig. 4.10, where Fig. 4.10a shows the damaged girder section at midspan, Fig. 4.10b illustrates the superstructure system at midspan, and Fig. 4.10c shows the end view of the bridge. It was anticipated that the bridge would not exhibit significant end restraint as the beams are not integral with the abutments (the same conditions at the abutments as for Bridge #1 as shown previously in Fig. 4.6a). This bridge, shown in plan view in Fig. 4.11 and in cross-section in Fig. 4.12, has a span length of 38 ft – 10 in from centerline to centerline of bearings with a roadway width of 17 ft and an overall width of 19 ft – 9 in. (one 12 ft traffic lane and two 2 ft – 6 in. shoulders).

The timber deck consists of a 4-in. thick wood plank system with a 6-in. gravel overlay without structural connection to the girders. The superstructure is comprised of eight girders and four lines of diaphragms bolted to the girders. The substructure consists of expansion bearings and timber backwalls. The exterior beams and the six interior beams are the same size and are spaced on 2 ft – 6 3/8 in. centers. Four of the eight girders were instrumented near the abutments, at midspan, and at quarterspan near the North abutment as shown in Fig. 4.11b. Two of the remaining four girders were instrumented near the North abutment and at midspan also shown in Fig. 4.11b. Each instrumented sections had a gage installed on the bottom surface of the top and bottom flanges as previously described such that a total of 40 gages were installed at 20 locations.

A loaded tandem-axle dump truck with a total weight of 49.58 k was used in the tests. Details for the truck are given in Fig. 4.13. Data were collected for three truck paths with two runs conducted for each path. Path Y1 was oriented such that the driver’s side wheel line was 8 ft – 11 in. from the far East girder (with the outer wheel line placed 2 ft from the centerline of the East girder), and path Y2 positioned the truck approximately over the center of the bridge with the driver’s side wheel line 11 ft – 11 in. from the East girder. Finally, path Y3 was oriented with the driver’s side wheel line 15 ft – 8 in. from the East girder (the outer wheel line was placed 2 ft from the West girder). Truck path information and gage locations are summarized in Fig. 4.11.
a. Bent girder on far West side at midspan.

b. Girders on East side at midspan.

c. End view of the bridge.

Figure 4.10. Bridge #2: Photographs of the bridge.
a. Overall bridge dimensions and truck paths Y2 and Y3.

b. Truck path Y1 and gage locations.

Figure 4.11. Bridge 2: Overall dimensions, gage locations, and truck paths.
Figure 4.12. Bridge #2: Cross-sections of the bridge and individual girder.

Figure 4.13. Bridge #2: Load Truck Details.
4.4. BRIDGE #3

Bridge #3, Iowa DOT Bridge Number 4824.1S 006 located in Iowa County, IA and built in 1929, is a composite, simple-span, steel-girder bridge with a concrete deck and no skew carrying US Highway 6 over a small natural stream. Based on a cursory visual inspection and photographic documentation, all steel sections appear to be in good condition with the exception of some light rust. As can be seen in Fig. 4.14b, it was anticipated that the bridge would not exhibit significant end restraint as the beams are not integral with the abutments. This bridge, shown in plan view in Fig. 4.15 and in cross-section in Fig. 4.16, has a span length of 70 ft from centerline to centerline of abutment bearings with a roadway width of 29 ft – 6 in. (two 12 ft lanes and two 2 ft – 9 in. shoulders).

The deck consists of a reinforced concrete-slab deck with a variable thickness (7 in. at the curb and 9 in. at the centerline), cast-in-place reinforced-concrete slab with a 3-in wearing surface. The superstructure is comprised of two exterior beams (on 31 ft centers), two main girders (on 21 ft – 9 in. centers), four interior stringers (on 4 ft centers), and six floor beams (see Fig. 4.15a for the spacing). As shown in Fig. 4.14c, a tapered steel section connects to the exterior beams to the main girders. The substructure is a reinforced-concrete abutment with expansion steel bearings and a reinforced-concrete wingwall. The four interior stringers consist of two different sections: the first section is bolted to the floor beams that are spaced 8 ft – 9 in., and the second section is bolted to the floor beams that are spaced 17 ft – 6 in. The exterior beams also consist of two different sections (shown in Fig. 4.14c): the first section is bolted to the non-uniform members that are spaced 8 ft – 9 in., and the second section is bolted to the non-uniform members that are spaced 17 ft – 6 in. The main girders are 41.38 in. deep and have various cover plates and 2 angles 8 in. x 3 in. x 1 in. attached. The angles are bolted in place (see Fig. 4.14c) over the middle 60 ft. The longest cover plate (welded to the bottom flange) is 14 in. x 1 in. x 45 ft long centered on the bridge. The second cover plate is 12 in. x 5/8 in. x 27 ft long, also centered on the bridge. A cross-section of the main girder near midspan is presented in Fig. 4.16b. Gages were installed at various critical locations: ten gage pairs were placed on the main girders, three gage pairs were placed on one of the stringers, and three gage pairs were placed on one of the floor beams. At all instrumented sections, gages were positioned on the bottom surface of the top and bottom flanges as previously described. In addition, one extra gage was installed on the top surface (bottom flange) of the angle (shown in Fig. 4.16a) at locations L3, L5 and L7 to determine the effectiveness of the angle. Gage locations are illustrated in Fig. 4.15; there are a total of 16 instrumented sections and 35 gages.
A loaded tandem-axle dump truck with a total weight of 49.4 k was used in the tests. Details of the load truck are given in Fig. 4.17. Data were collected for the five truck paths shown in Fig. 4.15 with two runs conducted for each path. All truck paths were oriented with respect to the driver’s side wheel line measured from the North girder: Path Y1 was located at 10 ft – 11 in. (with the passenger side wheel line approximately on the North girder), Path Y2 was located at 8 ft – 8 in. (with the passenger side wheel line 2 ft from the North curb), Path Y3 was located at 16 ft – 2 in. (with the passenger side wheel line approximately on one of the interior stringers), Path Y4 was located at 18 ft – 10 in. (with the truck approximately on the center of the bridge), and Path Y5 was located at 25 ft – 8 in (with the driver’s side wheel line approximately on the South girder).

![End view of bridge](image1.png)

**a. End view of bridge**

![Abutment](image2.png)

**b. Abutment.**

Figure 4.14. Bridge #3: Photographs of the bridge.
c. The non-uniform section bolted to the main girder.

c. Superstructure system.

d. Side view of bridge.

Figure 4.14. Continued.
a. Overall dimensions and truck paths Y1, Y2 and Y5.

b. Gage Locations and truck paths Y3 and Y4.

Figure 4.15. Bridge #3: Overall dimensions, gage locations, and truck paths.
Figure 4.16. Bridge #3: Typical cross-sections of the bridge and the main girder at midspan.

Figure 4.17. Bridge #3: Load Truck Details.
4.5. BRIDGE #4

Bridge #4, Iowa DOT Bridge Number 4821.9O 080, located in Iowa County, IA, carries FM W-16 (2.1 miles East of Jct. 149) over Interstate 80. This bridge, which was built in 1963, is a no skew, composite, four-span, steel-girder bridge with a concrete deck. Based on a visual inspection and photographic documentation, all structural elements appear to be in good condition (shown in Fig. 4.18). It was anticipated that the bridge would not exhibit significant end restraint as the beams are not integral with the abutments. Since this bridge is symmetric about the centerline, only half of this bridge is shown in plan view in Fig 4.19; a cross-section of the bridge is presented in Fig. 4.20. The total length of this bridge is 216 ft: Span 1 and Span 4 are 46 ft – 6 in. while Span 2 and Span 3 are 61 ft – 6 in. measured from centerline to centerline of bearings. This bridge has a roadway width of 24 ft and an overall width of 26 ft – 4 in. (two 12 ft traffic lanes and two 1 ft – 2 in. shoulders).

The deck consists of a variable thickness (i.e., 6 in. at the curb and 9 in. at the centerline) cast-in-place reinforced-concrete slab with a 1/2-in. wearing surface. The superstructure is comprised of two exterior girders (spaced 20 ft – 2 in. centers) and thirteen floor beams (spaced as illustrated in Fig. 4.19). The substructure is a reinforced-concrete abutment with steel expansion bearings at the abutments and at the piers, and a reinforced-concrete backwall. The girders consist of three different sections: one section near the abutments and in the vicinity of midspan (shown in Fig. 4.20d), one section at Pier 1 extending 9 ft to the South and 8 ft – 6 in. to the North of the pier (shown in Fig. 4.20e), and the third section at Pier 2 extending 9 ft on both sides of the pier (shown in Fig. 4.20c). The floor beams consist of two different sections: one section aligned at centerline of the abutment bearings (18 WF 45 as shown in the Steel Manual (5)), and one section for all other floor beams (21 WF 55 as shown in Steel Manual (5)) and illustrated in Fig. 4.20b. All floor beams are bolted to the main girders. The girders were instrumented near the South abutment (4 gages), at midspan of Span 1 (4 gages), near Pier 1 (8 gages), at the midspan of Span 2 (4 gages), and on the South side of Pier 2 (4 gages). In addition, one of the floor beams was instrumented at 4 locations with 2 gages at each location. Top and bottom flanges were instrumented at all 16 instrumented sections as previously described, thus, as shown in Fig. 4.19, there were a total of 32 gages on the bridge instrumented at 16 locations.

A loaded tandem-axle dump truck with a total weight of 47.72 k was used in the tests. Details for the load truck are given in Fig. 4.21. Data were collected for four truck paths as shown in Fig. 4.19. Path Y1 was oriented with the passenger’s side wheel line side approximately over the East girder, Path Y2 was oriented with the passenger’s side wheel line side approximately over the center of the bridge, Path Y3 was oriented with the truck positioned approximately over the center of the
bridge, and Path Y4 was oriented with the driver’s side wheel line approximately over the West girder.

Figure 4.18. Bridge #4: Photographs of the bridge.
Figure 4.19. Bridge #4: Overall dimensions, gage locations, and truck paths.
a. Cross-section of the bridge at midspan.

b. Cross-section of the floor beam: 21WF 55.

c. Cross-section of the girder at second pier.

Figure 4.20. Bridge #4: Typical cross-sections of the steel beams and the bridge.
d. Girder near the abutments and in the vicinity of midspan.

e. Girder at first pier.

Figure 4.20. Continued.
4.6. BRIDGE #5

Bridge #5, Iowa DOT Bridge Number 3150.7A 052, located in Dubuque County, IA is a non-composite, simple-span, steel-girder bridge with a concrete deck and no skew. This bridge, which was built in 1965, carries IA #386 (0.2 miles North of South Jct. US #52) over a drainage ditch. Based on a cursory visual inspection and photographic documentation, all steel sections appear to be in good condition with the exception of some small areas of corrosion on the girders (shown in Fig. 4.22d). The deck appears to be in good condition with the exception of some minor cracking (shown in Fig. 4.22e) and small spalled areas (shown in Fig. 4.22f). As can be seen in Fig. 4.22d, it was anticipated that the bridge would exhibit significant end restraint as the beams are integral with the abutments. This bridge, shown in plan view in Fig. 4.23 and in cross-section in Fig. 4.24, has a span length of 25 ft (clear span) between the abutments with a roadway width of 18 ft and an overall width of 19 ft – 8 in. (one 12 ft traffic lane and two 3 ft shoulders).

The deck consists of an 8-in. thick reinforced cast-in-place concrete-slab with an original 0.25-in. P.C. overlay and an additional 1.5-in. P.C. overlay that was placed in 1994 (see Fig. 4.24a). The superstructure is comprised of five girders and three diaphragm lines. The substructure is a reinforced-concrete abutment with fixed steel bearings and a reinforced-concrete backwall. Originally, the bridge only had four girders. However, it was widened in 1984 with a new girder added to the East side of the bridge. The new girder (shown in Fig. 4.24a) was tied in on the East side of the bridge with the construction joint shown in Fig. 4.22e. The cross-sections of the girders are
illustrated in Figs. 4.24b and 4.24c. All girders were instrumented 2 ft from the abutments and at midspan as shown in Fig. 4.23. Each instrumented section had a gage installed on the bottom surface of the top and bottom flanges.

A loaded tandem-axle dump truck with a total weight of 45.3 k was used in the tests. Details for the load truck are given in Fig. 4.25. Data were collected for the two truck paths shown in Fig. 4.23 with two runs conducted for each path. Path Y1 was oriented such that the driver’s side wheel line was approximately over the center girder, while Path Y2 had the passenger’s side wheel line over the center girder.

Figure 4.22. Bridge #5: Photographs of the bridge.
c. Abutment, superstructure system, and gage installation.

d. Abutment.

e. Concrete cracks.

f. Concrete deterioration.

Figure 4.22. Continued.
Figure 4.23. Bridge #5: Overall dimensions, gage locations, and truck paths.

Figure 4.24. Bridge #5: Typical cross-sections of the girders and the bridge.
b. Cross-section of the new girder.

c. Cross-section of the old Girder.

Figure 4.24. Continued.

Figure 4.25. Bridge #5: Load Truck Details.
4.7.  BRIDGE #6

Bridge #6, Iowa DOT Bridge Number 7530.7A 140, located in Plymouth County, IA, is a simple-span, concrete-slab bridge with no skew. This bridge, which was built in 1957, carries Iowa State Highway 140 over a drainage ditch 3.8 miles North of Kingsley. Based on a cursory visual inspection and photographic documentation (shown in Fig. 4.26) all structural elements appeared to be in good condition. It was anticipated that the bridge would exhibit significant end restraint since there are no abutment deck expansion joints. This bridge, shown in plan view in Fig. 4.27 and in cross-section in Fig. 4.28 has a span length of 20 ft from centerline to centerline of the abutment bearings with a roadway width of 38 ft and an overall structure width of 40 ft (two 12 ft traffic lanes and two shoulders – one 8 ft wide and the other 6 ft wide).

The deck consists of a uniform 15-in. thick P.C concrete deck with earth fill and Asphaltic Concrete (A.C) pavement over it. The superstructure is a single span concrete-slab structure. The substructure consists of wood pile abutments with wood backing plank and concrete caps. The roadway is offset 1 ft to the East of the bridge centerline as shown in Fig. 4.28. Only one gage was installed at each instrumented sections (placed on the bottom surface of the slab) because the fill on top of the deck made the placement of transducers on top of the slab difficult. As a result, locating the neutral axis locations for this bridge is difficult. Three gages were installed on top of the West curb so the location of the neutral axis at these locations (L1, L2, and L3) could be determined. Thus, there were a total of 24 gages on the bridge installed at 21 locations, as shown in Fig. 4.27b. Gage extensions (15 in. in length) were used for all gages.

A loaded tandem-axle dump truck with a total weight of 52.1 k was used in the tests. Details for the truck are given in Fig. 4.29. Data were collected for four truck paths as shown in Fig. 4.27. Path Y1 was oriented such that the driver’s side wheel line was located 4 ft from the West edge. Path Y2 was oriented with the driver’s side wheel line 11 ft – 6 in. from the West edge. Path Y3 was oriented with the passenger side wheel line 11 ft – 6 in. from the East edge. Finally, path Y4 was oriented with the passenger side wheel line 4 ft from the East edge.
a. Gage installation on the bottom of the slab.

b. Side view of bridge.

c. End view of bridge with truck path Y4.

Figure 4.26. Bridge #6: Photographs of the bridge.
a. Overall dimensions and truck paths Y1 and Y4.

b. Gage locations and truck paths Y2 and Y3.

Figure 4.27. Bridge #6: Overall dimensions, gage locations and truck paths.
Figure 4.28. Bridge #6: Cross-section of the bridge at midspan.

Figure 4.29. Bridge #6: Load Truck Details.

4.8. BRIDGE #7

Bridge #7, Iowa DOT Bridge Number 3718.7S 030, located in Boone County, IA, is a simple-span, concrete-slab bridge with no skew. This bridge, which was built in 1921, carries US Highway 30 over Little Beaver Creek. Based on a cursory visual inspection, there are many concerns with the bridge. The top of the deck has many hairline to wide longitudinal cracks, several hairline to narrow transverse cracks, and a few spalls along both ends of the deck. Two of the wide longitudinal cracks extend the full length of the deck, and both curbs have a few hairline vertical cracks. Photographs of this bridge are presented in Fig. 4.30: showing spalling and heavy deterioration at the edge (shown in Fig. 4.30a), a side view of bridge (shown in Fig. 4.30c), and the reinforcing steel bars exposed on bottom of the slab (shown in Fig. 4.30c). It was anticipated that the bridge would not
a. Spalling and heavy deterioration at edge.

b. Side view of bridge.

c. Reinforcing steel bars exposed on bottom of slab.

Figure 4.30. Bridge #7: Photographs of the bridge.
exhibit significant end restraint since there are abutment deck joints with a few narrow transverse cracks. This bridge, shown in plan view in Fig. 4.31 and in cross-section in Fig. 4.32, has a span length of 25 ft from centerline to centerline of abutment bearings with a roadway width of 30 ft and an overall structure width of 32 ft – 4 in. (two 12 ft traffic lanes and two 3 ft shoulders). Originally (in 1921), the roadway width measured 24 ft, but the bridge was widened in 1952 to accommodate two traffic lanes.

The deck consists of a uniform P.C. concrete-slab. The original slab thickness was 1 ft – 10 in., but was increased to 2 ft in 1952. In addition, the bridge was overlaid with additional concrete in 1978 such that the total deck thickness varied (i.e., 29 in. at the curb, and 33 in. at the centerline). The construction joint created due to the bridge widening (shown in Fig. 4.31) is located at approximately 6 ft from the East edge if the bridge. The superstructure is a single span concrete-slab structure. The substructure is a full height concrete abutment supported on untreated wood fiction piling and a concrete wingwall. The instrumentation focused on the construction joint created during the widening of the bridge to establish its ability to transfer loads across the joint: gage pairs were installed on top and bottom surfaces of the deck at locations L14, L17 and L20 (shown in Fig. 4.31). However, these gages on top of the slab were only included for Path Y2 so that they would not be damaged while the truck was driven along other paths. The tops of the concrete rails were also instrumented near the abutments and at midspan (i.e., at locations L1, L2, L3, L22, L23 and L24) to quantify its contribution to edge stiffening. In addition, gages were placed on the bottom of the slab at all instrumented sections, thus there were a total of 33 gages (for Path Y2) on the bridge installed at 24 locations, as shown in Fig. 4.31. For all other paths, a total of 30 gages on the bridge were installed. Gage extensions (12 in. in length) were used for all gages on the bottom of the slab. No gage extensions were used for gages on top of the slab and on the curb.

A loaded tandem-axle dump truck with a total weight of 44.44 k was used in the tests. Details for the truck are given in Fig. 4.34. Data were collected for five truck paths as shown in Fig. 4.32, where the truck paths were oriented as follows with respect to the left wheel line measured from the Eastern structure end: path Y1 was 10 ft – 1 in. from the end, path Y2 was 16 ft from the end and path Y3 was 12 ft – 10 in. from the end. With respect to the left wheel line measured from the Western structure end: path Y4 was 2 ft – 9 in. from the end and path Y5 was 5 ft – 6 in. from the end (shown in Fig. 4.37b).
Figure 4.31. Bridge #7: Overall dimensions and gage locations.

Figure 4.32. Bridge #7: Cross-section of the bridge at midspan.
a. Truck paths Y1 and Y4.

b. Truck paths Y2 and Y5.

c. Truck path Y3.

Figure 4.33. Bridge #7: Truck path information.
Figure 4.34. Bridge #7: Load Truck Details.
5. MODEL VERIFICATION AND BRIDGE RATING RESULTS

This chapter presents the results obtained for the bridge used in the modeling verification process and for the bridges tested as part of this investigation. Included, for each bridge, is information on the preliminary investigation of data, a description of the analytical model, analytical results such as statistics and data, and rating results. Also included is information on a sensitivity test conducted on the Cedar Creek Bridge model, a partial proof load test completed on Bridge #1 using a full, half-full, and empty truckload, and a test that was performed for Bridge #2 to verify that one can predict strains at locations where there is no instrumentation.

5.1. CEDAR CREEK BRIDGE: MODEL VERIFICATION

As shown in Fig. 5.1a, Cedar Creek Bridge exhibits compression in the girder bottom flange near the abutment. This indicates that end restraint exists. The location of the neutral axis lies approximately in the top flange as illustrated in Fig. 5.1a by the relatively small top flange strain levels shown; hence composite action is verified. Moreover, experimental strains presented in Figs. 5.1b and 5.1c illustrate transverse and longitudinal strain symmetry, respectively. The data for transverse symmetry show that maximum compression strains are approximately the same magnitude (15-20 microstrain). Longitudinal strain symmetry, to investigate boundary condition similarities, is difficult to verify due to the unidirectional movement of the load truck; however, longitudinal strain symmetry was assumed since the strains were relatively small.

Based on the initial review of the data briefly discussed in the previous paragraph, an analytical model was created as shown in Fig. 5.2 using twelve elements in the longitudinal direction and nine elements in the transverse direction. Translational springs (with an eccentricity of 30 in. from the neutral axis to bottom flange) were included for all girders at the centerline of the abutment to simulate possible end restraint. Since the potential for moment reversal exists due to the significant end restraint, all girders were modeled with two different sections along the length (i.e., a positive and a negative moment section). In addition, the exterior girders were modeled separately from the interior girders to account for possible edge stiffening. All girder sections were modeled with beam elements. The reinforced concrete slab was modeled with quadrilateral plate elements with a uniform thickness of 8.28 in. Table 5.1 summarizes the optimized model parameter results. These data indicate that most results compare well with results previously obtained by BDI. The only exception is the optimized value for the exterior beam near the abutment where the BDI value is almost twice the ISU value. A possible explanation for this is that different neutral axis locations may have been
a. Experimental strains at Location L9 for Path Y1.

b. Experimental strains showing transverse strain symmetry for bottom flanges.

c. Comparison of experimental strains for bottom flanges to identify longitudinal strain symmetry.

Figure 5.1. Cedar Creek Bridge: End restraint, composite action and strain symmetry.
used by BDI and herein. The optimized stiffness parameters depend on the distance from the neutral axis to bottom gage, and if this distance is significantly different in the two models, the optimized stiffness parameters will also be different.

Figure 5.2. Cedar Creek Bridge: Bridge mesh, gage locations and section property names.

Table 5.1. Cedar Creek Bridge: Adjustable parameters.

<table>
<thead>
<tr>
<th>Section</th>
<th>Property</th>
<th>Units</th>
<th>Optimized value</th>
<th>%</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>BDI value</td>
<td>ISU value</td>
</tr>
<tr>
<td>Slab modulus</td>
<td>E</td>
<td>ksi</td>
<td>5,815</td>
<td>5,990</td>
</tr>
<tr>
<td>Exterior beam at midspan</td>
<td>I_y</td>
<td>in^4</td>
<td>29,460</td>
<td>29,340</td>
</tr>
<tr>
<td>Exterior beam near abutment</td>
<td>I_y</td>
<td>in^4</td>
<td>15,910</td>
<td>7,970</td>
</tr>
<tr>
<td>Interior beam at midspan</td>
<td>I_y</td>
<td>in^4</td>
<td>16,660</td>
<td>17,360</td>
</tr>
<tr>
<td>Interior beam near abutment</td>
<td>I_y</td>
<td>in^4</td>
<td>10,490</td>
<td>11,270</td>
</tr>
<tr>
<td>Abutment spring (translational)</td>
<td>K_x</td>
<td>Kips/in</td>
<td>1,770</td>
<td>1,470</td>
</tr>
</tbody>
</table>
The accuracy of the model is shown graphically in Fig. 5.3 for typical data at various locations. Generally, the model results and experimental results compare well. Table 5.2 summarizes the model accuracy in statistical terms. These data also illustrate the similarity between the two models (i.e., BDI and ISU), and shows a very good correlation. The absolute errors and the scale error differ slightly, but the differences are possibly due to reasons as previously mentioned (using a different location of the neutral axis for the exterior beam near the abutment).

Table 5.2. Cedar Creek Bridge: Model accuracy.

<table>
<thead>
<tr>
<th>Statistical Term</th>
<th>Units</th>
<th>Final value</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>BDI value</td>
<td>ISU value</td>
<td></td>
</tr>
<tr>
<td>Absolute Error</td>
<td>Microstrain</td>
<td>911</td>
<td>836</td>
<td></td>
</tr>
<tr>
<td>Percent Error</td>
<td>%</td>
<td>6.0</td>
<td>5.8</td>
<td></td>
</tr>
<tr>
<td>Scale Error</td>
<td>%</td>
<td>4.2</td>
<td>7.2</td>
<td></td>
</tr>
<tr>
<td>Correlation Coefficient</td>
<td>-</td>
<td>0.97</td>
<td>0.97</td>
<td></td>
</tr>
</tbody>
</table>

In addition to comparing the overall results, a sensitivity study was conducted using the optimized model. In this study, the neutral axis location for the interior beams in the midspan region was varied. The purpose of this was to observe what influence changing the neutral axis location would have on the optimized stiffness parameters (shown in Table 5.3), on the moment distribution (shown in Table 5.4), and on the accuracy of the modeling and optimization process (shown in Table 5.5). This was completed because one important step in the initial model generation is the establishment of the neutral axis location. Typically, this is determined from the strain data. However, this is a subjective determination. To study the impact of this determination, the neutral axis location was “moved” by changing the effective width of the concrete slab in the composite steel section for the interior girders near midspan, and the optimization was re-run. When optimizing the models for each neutral axis location, the same truck paths were used as previously described. Table 5.3 shows the difference in stiffness parameter values due to variations in neutral axis locations and indicates that all parameters vary slightly due to a change in the neutral axis at a single location (i.e., interior beam at midspan). The moments shown in Table 5.4 are the maximum girder live load moments when the field truck is positioned as shown in Fig. 5.4 (Path Y2 previously shown in Fig. 4.2). By varying the neutral axis location by 7 in., the midspan moments varied by up to 10 % and the moments near the abutment varied by up to 25%. These differences illustrate the importance of
a. Experimental strains and analytical strains at Location L9.

b. Experimental and analytical strains at Location L8.

c. Experimental and analytical strains at Location L11.

Figure 5.3. Cedar Creek Bridge: Typical experimental and analytical strains for load Path Y1.
establishing accurate neutral axis locations. The difference in model accuracies are illustrated in Table 5.5, and shows that the percent error (which is the objective function for the optimization process) varies between 5.8 % and 7.3 %, depending on the neutral axis location.

Table 5.3. Cedar Creek Bridge: Stiffness parameters from Sensitivity Test when changing the location of the neutral axis for the interior girders at midspan.

<table>
<thead>
<tr>
<th>Section</th>
<th>Property</th>
<th>Units</th>
<th>23</th>
<th>24</th>
<th>25</th>
<th>26</th>
<th>27</th>
<th>28</th>
<th>29</th>
<th>30</th>
</tr>
</thead>
<tbody>
<tr>
<td>Int beam - abut</td>
<td>I_y</td>
<td>in^4</td>
<td>10,330</td>
<td>10,590</td>
<td>10,880</td>
<td>11,230</td>
<td>11,610</td>
<td>12,000</td>
<td>12,390</td>
<td>12,850</td>
</tr>
<tr>
<td>Ext beam - mid</td>
<td>I_y</td>
<td>in^4</td>
<td>29,910</td>
<td>29,750</td>
<td>29,570</td>
<td>29,350</td>
<td>29,120</td>
<td>28,860</td>
<td>28,590</td>
<td>28,270</td>
</tr>
<tr>
<td>Ext beam - abut</td>
<td>I_y</td>
<td>in^4</td>
<td>8,950</td>
<td>8,660</td>
<td>8,340</td>
<td>8,000</td>
<td>7,655</td>
<td>7,300</td>
<td>6,945</td>
<td>6,600</td>
</tr>
<tr>
<td>Int beam - mid</td>
<td>I_y</td>
<td>in^4</td>
<td>15,500</td>
<td>16,010</td>
<td>16,590</td>
<td>17,290</td>
<td>18,070</td>
<td>18,920</td>
<td>20,260</td>
<td>20,840</td>
</tr>
<tr>
<td>Deck</td>
<td>E</td>
<td>ksi</td>
<td>5,480</td>
<td>5,715</td>
<td>5,985</td>
<td>6,000</td>
<td>6,000</td>
<td>6,000</td>
<td>6,000</td>
<td>6,000</td>
</tr>
<tr>
<td>Spring (translational)</td>
<td>F_x</td>
<td>K/in</td>
<td>1,410</td>
<td>1,425</td>
<td>1,445</td>
<td>1,470</td>
<td>1,490</td>
<td>1,520</td>
<td>1,540</td>
<td>1,565</td>
</tr>
</tbody>
</table>

Figure 5.4. Cedar Creek Bridge: Truck position in sensitivity test.
Table 5.4. Cedar Creek Bridge: Maximum moments from Sensitivity Test when changing the location of the neutral axis for the interior girders at midspan.

<table>
<thead>
<tr>
<th>Section</th>
<th>Property</th>
<th>Units</th>
<th>23</th>
<th>24</th>
<th>25</th>
<th>26</th>
<th>27</th>
<th>28</th>
<th>29</th>
<th>30</th>
</tr>
</thead>
<tbody>
<tr>
<td>Int beam - abut</td>
<td>$M_y$</td>
<td>K-in</td>
<td>150</td>
<td>145</td>
<td>140</td>
<td>137</td>
<td>134</td>
<td>130</td>
<td>124</td>
<td>123</td>
</tr>
<tr>
<td>Ext beam - mid</td>
<td>$M_y$</td>
<td>K-in</td>
<td>1,450</td>
<td>1,445</td>
<td>1,435</td>
<td>1,410</td>
<td>1,400</td>
<td>1,385</td>
<td>1,360</td>
<td>1,350</td>
</tr>
<tr>
<td>Ext beam - abut</td>
<td>$M_y$</td>
<td>K-in</td>
<td>78</td>
<td>80</td>
<td>82</td>
<td>85</td>
<td>87</td>
<td>90</td>
<td>93</td>
<td>97</td>
</tr>
<tr>
<td>Int beam - mid</td>
<td>$M_y$</td>
<td>K-in</td>
<td>1,415</td>
<td>1,420</td>
<td>1,430</td>
<td>1,450</td>
<td>1,475</td>
<td>1,505</td>
<td>1,545</td>
<td>1,560</td>
</tr>
</tbody>
</table>

Table 5.5. Cedar Creek Bridge: Model accuracy from Sensitivity Test when changing the location of the neutral axis for the interior girders at midspan.

<table>
<thead>
<tr>
<th>Statistical Term</th>
<th>Units</th>
<th>23</th>
<th>24</th>
<th>25</th>
<th>26</th>
<th>27</th>
<th>28</th>
<th>29</th>
<th>30</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Error</td>
<td>Microstrain</td>
<td>956</td>
<td>910</td>
<td>868</td>
<td>838</td>
<td>836</td>
<td>852</td>
<td>880</td>
<td>913</td>
</tr>
<tr>
<td>% Error</td>
<td>%</td>
<td>7.3</td>
<td>6.5</td>
<td>6.0</td>
<td>5.8</td>
<td>5.8</td>
<td>6.0</td>
<td>6.3</td>
<td>6.8</td>
</tr>
<tr>
<td>Scale Error</td>
<td>%</td>
<td>12.8</td>
<td>10.8</td>
<td>9.0</td>
<td>7.3</td>
<td>6.2</td>
<td>7.8</td>
<td>9.2</td>
<td>10.7</td>
</tr>
<tr>
<td>Correlation Coefficient</td>
<td>-</td>
<td>0.963</td>
<td>0.967</td>
<td>0.967</td>
<td>0.971</td>
<td>0.971</td>
<td>0.970</td>
<td>0.968</td>
<td>0.966</td>
</tr>
</tbody>
</table>

5.2. BRIDGE #1

As shown in Fig. 5.5a, compression was induced in the top flange and tension occurred in the bottom flange near the abutment. This indicates that Bridge #1 exhibits little end restraint. The location of the neutral axis lies approximately at mid depth of the steel sections since strains are approximately the same for both top and bottom gages at midspan as shown in Fig. 5.5b; hence non-composite action is verified. Moreover, the strain is symmetric in the transverse direction as shown in Fig. 5.5c. Strain symmetry in the longitudinal direction was not possible to verify as no gages were installed near the West abutment (shown in Figs. 4.7b and 5.6).

Based on the initial review of the data briefly discussed in the previous paragraph, an analytical model (named Model 1 for future reference) was created as shown in Fig. 5.6 using one element between each girder in the transverse direction and twelve elements in the longitudinal direction. The channel diaphragms were not included in the analytical model because the BDI Software treats transverse beams as floor-beams. Therefore, it is appropriate to disregard the diaphragms in the analytical model. Even though experimental data indicate insignificant presence of
a. Experimental strains for Path Y3 at Location L11

b. Experimental strains for Path Y3 at Location L5.

c. Experimental strains showing transverse strain symmetry.

Figure 5.5. Bridge #1: End restraint, non-composite action and strain symmetry.
of end restraint, rotational springs were included for all girders at the centerline of the abutment bearings to verify this behavior. As indicated by the experimental data, the girders in the analytical model were modeled as one uniform, non-composite section. In addition, the rail did not contribute to any edge stiffening (the neutral axis location for an exterior girder lies approximately at mid depth as shown in Fig. 5.7a), so the exterior girders were not distinguished from the interior girders. The girder section was modeled with beam elements and the timber deck was modeled with quadrilateral plate elements with a uniform thickness of 4 in. Table 5.6 summarizes the optimized stiffness parameter results. These results indicate that all optimized stiffness parameters (excluding the springs) compare very well with the initial parameters. The magnitude of the optimized spring value (21,000 in-k/rad) is insignificant, indicating a nearly pinned condition; a 90 % fixed case would have a rotational restraint (in-k/rad) to the power of six.

![Diagram](image)

Figure 5.6. Bridge #1: Bridge mesh, gage locations and section property names.

<table>
<thead>
<tr>
<th>Section</th>
<th>Property</th>
<th>Units</th>
<th>Initial</th>
<th>Optimized</th>
</tr>
</thead>
<tbody>
<tr>
<td>Girder</td>
<td>I_y</td>
<td>in^4</td>
<td>1,480</td>
<td>1,560</td>
</tr>
<tr>
<td>Timber deck</td>
<td>E</td>
<td>ksi</td>
<td>1,000</td>
<td>925</td>
</tr>
<tr>
<td>Spring (rotational)</td>
<td>K_y</td>
<td>in-k/rad</td>
<td>0</td>
<td>21,090^a</td>
</tr>
</tbody>
</table>

^a Corresponds to approximately 5 % fixity.
Figure 5.7 Bridge #1: Typical strain plots using Path Y1 and full truckload.

a. Location L1.

b. Location L3.

c. Location L9.
The accuracy of the model is shown graphically in Fig. 5.7 for typical data at various locations using the “full” truckload condition, where Fig. 5.7a compares exterior girder strains at midspan, Fig. 5.7b shows interior girder strains at midspan, and Fig. 5.7c illustrates interior girder strains near the abutment. All results are very comparable. Table 5.7 summarizes the model accuracy and also shows a very good correlation. The initial model assuming a simply supported condition and initial section property values results in an error of only 4.4%. This low initial error verifies that the bridge is almost simply supported and that the girders are non-composite. The optimized error of 2.2% implies a very good correlation of the experimental and analytical data.

Table 5.7. Bridge #1: Model accuracy for the full truckload.

<table>
<thead>
<tr>
<th>Statistical Term</th>
<th>Units</th>
<th>Initial</th>
<th>Optimized</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Error</td>
<td>microstrain</td>
<td>3,924</td>
<td>2,674</td>
</tr>
<tr>
<td>% Error</td>
<td>%</td>
<td>4.4</td>
<td>2.2</td>
</tr>
<tr>
<td>% Scale Error</td>
<td>%</td>
<td>6.7</td>
<td>2.4</td>
</tr>
<tr>
<td>Correlation Coefficient</td>
<td>-</td>
<td>0.99</td>
<td>0.99</td>
</tr>
</tbody>
</table>

By using this optimized model with the appropriate rating trucks and by applying dead load to the structure, the rating model was developed. Dead load applied to the structure includes the self-weight of the steel girders and a four-in. thick timber deck, a 6.5 in. x 6.5 in. wood curb applied to the exterior girders, a weight of 25 lb/ft distributed uniformly over both exterior girders to take into account the steel rail on top of the wood curb, a uniform load distributed over the interior beams to account for the dead load of the diaphragms, and an additional 1 in. deep asphalt and 3 in. gravel overlay on top of the timber deck. For rating purposes, the following truck paths were considered:

- Paths A and B: The outer wheel line two ft from each curb.
- Paths C, D, E and F: The outer wheel line on the four interior girders to the far North.
- Path G: The outer wheel line on the interior girder to the far South.
- Path H: The truck centered across roadway width.

Each path was analyzed at 6 in. intervals in the longitudinal direction. The bridge was designed as a single-lane bridge, so no truck path combinations were considered. Individual member capacities were calculated following appropriate AASHTO Standard Specifications (4). Table 5.8 and Table 5.9 present the resulting ratings by the LFD Method (by applying AASHTO Standard Specifications (4)) and by using the BDI Software, respectively. These results show that all BDI Method ratings are
greater than the LFD ratings. Table 5.10 summarizes the percent difference in Inventory Ratings between the LFD Method and the BDI Method (note: a positive percent difference indicates that the BDI Software rating value is greater than the LFD Method rating value, and negative percent difference indicates that the BDI rating value is less than the LFD Method value). The critical rating condition is for flexure at the interior girder (0.81 by the LFD Method and 1.17 by the BDI Method for a difference of 44%). It should be pointed out that lane loadings were investigated in accordance with AASHTO Standard Specifications (4) and found to not be critical.

Table 5.8. Bridge #1: Design Truck Rating Factors by the LFD Method.

<table>
<thead>
<tr>
<th>Section</th>
<th>HS-20 Flexure</th>
<th>Shear</th>
<th>H-20 Flexure</th>
<th>Shear</th>
<th>Type-3 Flexure</th>
<th>Shear</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interior Girders</td>
<td>0.81 Inv.  Ope.</td>
<td>3.18 Shear</td>
<td>0.81 Inv.  Ope.</td>
<td>3.18 Shear</td>
<td>0.81 Inv.  Ope.</td>
<td>3.18 Shear</td>
</tr>
<tr>
<td>Exterior Girders</td>
<td>0.90 Inv.  Ope.</td>
<td>3.54 Shear</td>
<td>0.90 Inv.  Ope.</td>
<td>3.54 Shear</td>
<td>0.90 Inv.  Ope.</td>
<td>3.54 Shear</td>
</tr>
</tbody>
</table>

*Inv. = Inventory Rating Factor
 Ope. = Operating Rating Factor

Table 5.9. Bridge #1: Design Truck Rating Factors by the BDI Software.

<table>
<thead>
<tr>
<th>Section</th>
<th>HS-20 Flexure</th>
<th>Shear</th>
<th>H-20 Flexure</th>
<th>Shear</th>
<th>Type-3 Flexure</th>
<th>Shear</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interior Girders</td>
<td>1.17 Inv.  Ope.</td>
<td>3.95 Shear</td>
<td>1.17 Inv.  Ope.</td>
<td>3.95 Shear</td>
<td>1.17 Inv.  Ope.</td>
<td>3.95 Shear</td>
</tr>
<tr>
<td>Exterior Girders</td>
<td>1.32 Inv.  Ope.</td>
<td>6.00 Shear</td>
<td>1.32 Inv.  Ope.</td>
<td>6.00 Shear</td>
<td>1.32 Inv.  Ope.</td>
<td>6.00 Shear</td>
</tr>
</tbody>
</table>

Table 5.10. Bridge #1: Percent difference in inventory ratings between LFD Method and BDI Software.

<table>
<thead>
<tr>
<th>Section</th>
<th>HS-20 Flexure</th>
<th>Shear</th>
<th>H-20 Flexure</th>
<th>Shear</th>
<th>Type-3 Flexure</th>
<th>Shear</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interior Girders</td>
<td>44.4</td>
<td>24.2</td>
<td>38.5</td>
<td>9.1</td>
<td>49.1</td>
<td>26.7</td>
</tr>
<tr>
<td>Exterior Girders</td>
<td>46.7</td>
<td>69.5</td>
<td>51.7</td>
<td>76.3</td>
<td>49.6</td>
<td>71.4</td>
</tr>
</tbody>
</table>

In addition to generating the previously described optimized model using a full truckload (Model 1 as previously described) and comparing the overall results, a sensitivity study was
completed by creating additional models using the half-full truck (Model 2) and the empty truck (Model 3) with the respective data. All three models were optimized separately with appropriate loads and strain results, with the adjustable stiffness parameters for each model presented in Table 5.11. These results illustrate that the optimized values for all three models are similar. Model accuracies are presented in Table 5.12 and Table 5.13, respectively, and show that all results compare very well indicating that the optimization process is, for this bridge, independent of the load used.

Table 5.11. Bridge #1: Adjustable parameters for all truckloads.

<table>
<thead>
<tr>
<th>Section</th>
<th>Property</th>
<th>Units</th>
<th>Initial</th>
<th>Optimized Full truck</th>
<th>Optimized Half-full truck</th>
<th>Optimized Empty truck</th>
</tr>
</thead>
<tbody>
<tr>
<td>Girder</td>
<td>Iy</td>
<td>in⁴</td>
<td>1,480</td>
<td>1,560</td>
<td>1,525</td>
<td>1,595</td>
</tr>
<tr>
<td>Timber deck</td>
<td>E</td>
<td>ksi</td>
<td>1,000</td>
<td>925</td>
<td>1,100</td>
<td>1,210</td>
</tr>
<tr>
<td>Spring (rotational)</td>
<td>Ky</td>
<td>in-k/rad</td>
<td>0</td>
<td>21,090</td>
<td>35,560</td>
<td>31,560</td>
</tr>
</tbody>
</table>

Table 5.12. Bridge #1: Model accuracy for the half-full truckload (Model 2).

<table>
<thead>
<tr>
<th>Statistical Term</th>
<th>Units</th>
<th>Initial</th>
<th>Optimized</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Error</td>
<td>microstrain</td>
<td>3,279</td>
<td>1,870</td>
</tr>
<tr>
<td>% Error</td>
<td>%</td>
<td>6.0</td>
<td>2.1</td>
</tr>
<tr>
<td>% Scale Error</td>
<td>%</td>
<td>11.2</td>
<td>2.7</td>
</tr>
<tr>
<td>Correlation Coefficient</td>
<td>-</td>
<td>0.98</td>
<td>0.99</td>
</tr>
</tbody>
</table>

Table 5.13. Bridge #1: Model accuracy for the empty truck (Model 3).

<table>
<thead>
<tr>
<th>Statistical Term</th>
<th>Units</th>
<th>Initial</th>
<th>Optimized</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Error</td>
<td>microstrain</td>
<td>2,035</td>
<td>1,259</td>
</tr>
<tr>
<td>% Error</td>
<td>%</td>
<td>8.1</td>
<td>5.0</td>
</tr>
<tr>
<td>% Scale Error</td>
<td>%</td>
<td>13.3</td>
<td>4.0</td>
</tr>
<tr>
<td>Correlation Coefficient</td>
<td>-</td>
<td>0.99</td>
<td>0.98</td>
</tr>
</tbody>
</table>

The half-full truck and the empty truck cases were also analyzed using Model 1 to observe the effect. When the half-full truck and the empty truck were analyzed with Model 1, the results are
referred to as M1 Half and M1 Empty (as shown in Table 5.14), respectively. The accuracies of these analyses are shown graphically in Fig. 5.8 for typical data at one location. All results show good correlation between experimental and analytical strains.

Table 5.14. Bridge #1: Model accuracy for M1 Half and M1 Empty.

<table>
<thead>
<tr>
<th>Statistical Term</th>
<th>Units</th>
<th>M1 Half</th>
<th>M1 Empty</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Error</td>
<td>microstrain</td>
<td>1,942</td>
<td>1,327</td>
</tr>
<tr>
<td>% Error</td>
<td>%</td>
<td>2.4</td>
<td>5.5</td>
</tr>
<tr>
<td>% Scale Error</td>
<td>%</td>
<td>4.2</td>
<td>4.7</td>
</tr>
<tr>
<td>Correlation Coefficient</td>
<td>-</td>
<td>0.99</td>
<td>0.97</td>
</tr>
</tbody>
</table>

5.3. BRIDGE #2

The experimental data presented in Fig. 5.9a at Location L4 show that compression was induced in the top flange and tension occurred in the bottom flange near the abutment. This indicates that Bridge #2 does not exhibit significant end restraint. The location of the neutral axis is approximately at mid depth of the steel sections since strains are approximately the same for both top and bottom gages at midspan also as shown in Fig. 5.9a at Location L8; hence non-composite action is verified. Moreover, typical strain plots indicating transverse symmetry are illustrated in Fig. 5.9b. Experimental strains are also presented in Fig. 5.9c to identify longitudinal strain symmetry (note: longitudinal strain symmetry difficult to verify due to the unidirectional movement of the load truck).

Based on the initial review of the data briefly discussed in the previous paragraph, an analytical model (Model 1) was created as shown in Fig. 5.10a using one element between each girder in the transverse direction and twelve elements in the longitudinal direction to obtain approximately square plate elements for the deck. The channel diaphragm lines were not included in the analytical model because the BDI Software treats transverse beams as floor-beams, hence it is appropriate to disregard the diaphragms in the analytical model. Even though experimental data indicate insignificant presence of end restraint, rotational springs were included for all girders at the centerline of the abutment bearings to verify this behavior. As a result of the experimental data indicating that all girders behave non-compositely, the girders in the analytical model were created as one uniform, non-composite section. In addition, the rail did not contribute to any edge stiffening (the neutral axis location for an exterior girder is approximately at mid depth as shown in Fig. 5.9a), so the exterior girders were not distinguished from the interior girders. The girder section was modeled with
Figure 5.8. Bridge #1: Typical strain plots at Location L5 using Path Y3.

a. Full truckload.

b. Half full truckload.

c. Empty truck.
a. Experimental strains for Path Y3 near the abutment and at midspan for an interior girder.

b. Experimental strains verifying transverse symmetry.

c. Comparison of experimental strains for bottom flanges to identify longitudinal strain symmetry.

Figure 5.9. Bridge #2: Typical data for end restraint, non-composite action and strain symmetry.
a. Gage instrumentation included in the optimization process.

b. Gage instrumentation for predicting strains using the optimized model.

Figure 5.10. Bridge #2: Bridge mesh, gage locations and section property names.
Table 5.15. Bridge #2: Adjustable parameters for Model 1.

<table>
<thead>
<tr>
<th>Section</th>
<th>Property</th>
<th>Units</th>
<th>Initial</th>
<th>Optimized</th>
</tr>
</thead>
<tbody>
<tr>
<td>Girder</td>
<td>I_y</td>
<td>in^4</td>
<td>1,230</td>
<td>1,255</td>
</tr>
<tr>
<td>Timber deck</td>
<td>E</td>
<td>ksi</td>
<td>1,000</td>
<td>845</td>
</tr>
<tr>
<td>Spring (rotational)</td>
<td>K_y</td>
<td>in-k/rad</td>
<td>0</td>
<td>29,210*</td>
</tr>
</tbody>
</table>

* Corresponds to approximately 8% fixity.

beam elements. The timber deck was modeled with quadrilateral plate elements with a uniform thickness of 4 in. Table 5.15 summarizes the optimized parameter results. These results indicate that all optimized parameters (excluding the springs) compare very well with the initial parameters. The magnitude of the optimized spring value (29,210 in-k/rad) is insignificant as previously discussed. The accuracy of the model is shown graphically in Fig. 5.11 for gages at the locations shown in Fig. 5.10a. Figure 5.11a compares exterior girder strains at midspan, Fig. 5.11b shows interior girder strains at midspan, and Fig. 5.11c illustrates interior girder strains near the abutment. All results compare well. Table 5.16 summarizes the model accuracy and verifies the good correlation. The initial model assuming a simply supported condition and the initial section property values results in an error of only 4.6%. This low initial value verifies that the bridge does not exhibit significant end restraint and that the girders are non-composite. The optimized error of 1.8% implies a very good correlation between the experimental and analytical data.

Table 5.16. Bridge #2: Model accuracy for initial and optimized model (Model 1).

<table>
<thead>
<tr>
<th>Statistical Term</th>
<th>Units</th>
<th>Initial</th>
<th>Optimized</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Error</td>
<td>microstrain</td>
<td>3,740</td>
<td>2,055</td>
</tr>
<tr>
<td>% Error</td>
<td>%</td>
<td>4.6</td>
<td>1.8</td>
</tr>
<tr>
<td>% Scale Error</td>
<td>%</td>
<td>6.1</td>
<td>1.5</td>
</tr>
<tr>
<td>Correlation Coefficient</td>
<td>N/A</td>
<td>0.99</td>
<td>0.99</td>
</tr>
</tbody>
</table>

The rating model was created by using the optimized model with the appropriate rating trucks and by applying dead load to the structure. Dead load applied to the structure includes the self-weight of the steel girders and a four-in. thick timber deck, a 6 in. x 15 in. wood curb applied on the exterior girders, a weight of 25 lb/ft distributed uniformly over both exterior girders to take into account the steel rail on top of the wood curb, a uniform load distributed over the interior beams to take into
a. Location L5.

b. Location L7.

c. Location L17.

Figure 5.11. Bridge #2: Typical strain plots for Path Y3 using optimized strains.
account the dead load of the diaphragms, and an additional 6-in. deep gravel overlay on top of the timber deck. For rating purposes, the following truck paths were considered:

- Paths A and B: The outer wheel line two ft from each curb.
- Paths C, D, E and F: The outer wheel line on the four interior girders to the far East.
- Path G: The outer wheel line on the interior girder to the far West.
- Path H: The truck centered across roadway width.

Each path was analyzed at 6 in. intervals in the longitudinal direction. The bridge was designed as a single-lane bridge, so no truck path combinations were created. Individual member capacities were calculated following appropriate AASHTO Standard Specifications (4). Table 5.17 and Table 5.18 show the ratings by the LFD Method (by applying AASHTO Standard Specifications (4)) and by using the BDI Software, respectively. Table 5.19 summarizes the percent difference in inventory ratings between the LFD Method and the BDI Method (note: a positive percent difference indicates that the BDI Software rating value is greater than the LFD Method rating value). The critical rating condition is for flexure at the interior girder (0.92 by the LFD Method and 1.31 by the BDI Method for a difference of 42 %). It should be pointed out that lane loadings were investigated in accordance with AASHTO Standard Specifications (4) and found to be not critical.

Table 5.17. Bridge #2: Design Truck Rating Factors by the LFD Method.

<table>
<thead>
<tr>
<th>Section</th>
<th>HS-20 Flexure</th>
<th>HS-20 Shear</th>
<th>H-20 Flexure</th>
<th>H-20 Shear</th>
<th>Type-3 Flexure</th>
<th>Type-3 Shear</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interior Girders</td>
<td>0.92</td>
<td>1.53</td>
<td>3.94</td>
<td>6.57</td>
<td>1.16</td>
<td>1.94</td>
</tr>
<tr>
<td>Exterior Girders</td>
<td>1.00</td>
<td>1.67</td>
<td>4.22</td>
<td>7.04</td>
<td>1.27</td>
<td>2.12</td>
</tr>
</tbody>
</table>

Table 5.18. Bridge #2: Design Truck Rating Factors by the BDI Method.

<table>
<thead>
<tr>
<th>Section</th>
<th>HS-20 Flexure</th>
<th>HS-20 Shear</th>
<th>H-20 Flexure</th>
<th>H-20 Shear</th>
<th>Type-3 Flexure</th>
<th>Type-3 Shear</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interior Girders</td>
<td>1.31</td>
<td>2.18</td>
<td>4.78</td>
<td>7.97</td>
<td>1.58</td>
<td>2.64</td>
</tr>
<tr>
<td>Exterior Girders</td>
<td>1.54</td>
<td>2.57</td>
<td>7.61</td>
<td>12.70</td>
<td>1.97</td>
<td>3.29</td>
</tr>
</tbody>
</table>
Table 5.19. Bridge #2: Percent difference in Design Truck Rating Factors between LFD Method and BDI Software.

<table>
<thead>
<tr>
<th>Section</th>
<th>HS-20 Flexure</th>
<th>HS-20 Shear</th>
<th>H-20 Flexure</th>
<th>H-20 Shear</th>
<th>Type-3 Flexure</th>
<th>Type-3 Shear</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interior Girders</td>
<td>42.4</td>
<td>21.3</td>
<td>36.2</td>
<td>5.7</td>
<td>49.6</td>
<td>24.6</td>
</tr>
<tr>
<td>Exterior Girders</td>
<td>54.0</td>
<td>80.3</td>
<td>55.1</td>
<td>80.3</td>
<td>56.7</td>
<td>75.5</td>
</tr>
</tbody>
</table>

As previously described, gages used in the testing were located near the abutments, at midspan and at the quarter-span near one end as shown in Fig. 4.11b. However, the gages included in the optimization process are shown in Fig. 5.10a (gage locations used in the optimization process for Bridge #2 are the same as for Bridge #1) and were located at midspan and near the North abutment. After the optimized model was obtained (based on the limited number of gages), the bridge was analyzed to predict the behavior at the locations not used in the optimization process (shown in Fig. 5.10b). The purpose of this study was to verify that it is possible to predict strains at locations where no gages are attached. It was found that the predicted strains (shown in Fig. 5.12) correlate very well with the experimental strains. The model accuracy with all gages included (including the gages not used in the optimization process) using the optimized model is presented in Table 5.20 and shows an error of 2.1 %.

Table 5.20. Bridge #2: Model accuracy for the optimized model including gage instrumentation for predicted strains.

<table>
<thead>
<tr>
<th>Statistical Term</th>
<th>Units</th>
<th>Optimized</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Error</td>
<td>microstrain</td>
<td>3,304</td>
</tr>
<tr>
<td>% Error</td>
<td>%</td>
<td>2.1</td>
</tr>
<tr>
<td>% Scale Error</td>
<td>%</td>
<td>1.9</td>
</tr>
<tr>
<td>Correlation Coefficient</td>
<td>N/A</td>
<td>0.99</td>
</tr>
</tbody>
</table>
Figure 5.12. Bridge #2: Typical strain plots for Path Y3 using predicted strains.

a. Location L3.

b. Location L11.

c. Location L13.
5.4. BRIDGE #3

As mentioned previously, it was anticipated that this bridge would not exhibit significant end restraint as the beams are not integral with the abutments. However, experimental results, as shown for typical strains on the girder near the abutment in Fig. 5.13a, indicate the presence of end restraint due to compression in the bottom flange. Further, as can be seen in Fig. 5.13b, the neutral axis is located near the top flange, hence composite action for the girder is verified. Figure 5.13c and Fig. 5.14a indicate that the neutral axis is located approximately in the top flanges for the stringers and the floor beams indicating the presence of composite action. Moreover, experimental strains are presented in Figs. 5.14b and 5.14c to illustrate transverse and longitudinal strain symmetry, respectively.

From the results described above, the analytical model shown in Fig. 5.15 was developed. Since end restraint was present in the experimental data, rotational springs were included for the girders at the centerline of the abutment bearings to verify this behavior. Four different sections for the main girders (all sections were previously described and account for the cover plates and the angle) that were used (Girder no angle, Girder no cover, Girder first cover and Girder second cover), three sections for the floor beams were used (25”8 Beth I 85.5, 27” Beth I 100, and 28” Beth I 113 as shown in the Steel Manual of 1930 (7)), and two sections for the exterior beams were used (Exterior beam at end, and Exterior beam at midspan) in the model. As described previously and shown in Fig. 4.14c, Bridge #3 has non-uniform transverse members between the exterior beams and the main girders. It is not possible to model non-uniform sections with the BDI Software; however, to approximate the behavior, each non-uniform member was divided into three uniform sections where each section was assigned average properties. The non-uniform members were also separated into two parts: one near the abutment and one near midspan. Hence, six different sections were created (i.e., End Plate 16.0, End Plate 19.7, End Plate 23.4, Int Plate 18.1, Int Plate 21.8 and Int Plate 25.5, where the numbers indicate the steel depth) to complete the model. Typical data verifying composite action are presented in Fig. 5.13b for the main girder, in Fig. 5.13c for the stringers, and in Fig. 5.14a for the floor beams. As a result, all sections were modeled as composite sections. Since some beam sections were modeled where no gages were attached, master-slave parameters were created for those sections (for these parameters, the slave parameter changes proportionally to the master parameter so that the ratio of the final optimized inertia-values for the two parameters (one slave and one master variable) is the same as the initial inertia-ratio). For this bridge, four slave parameters were selected in the optimization process since no gages were installed on these sections, where each of the four parameters was assigned to a corresponding master variable:
a. Strains on a girder near the abutment (Location L1).

b. Strains on a girder at midspan (Location L7).

c. Strain on a stringer at midspan (Location L12).

Figure 5.13. Bridge #3: Experimental strains verifying end restraint and composite action.
Figure 5.14. Bridge #3: Experimental strains verifying composite action and strain symmetry.

a. Strains on a floor beam at midspan (Location L16).

b. Transverse strain symmetry.

c. Longitudinal strain symmetry for Path Y1.
Girder with no cover plates was a slave to the Girder first cover (main girder).

- 25"8 Beth I 85.5 was a slave to 28" Beth I 113 (floor beam).
- 27" Beth I 100 was a slave to 28" Beth I 113 (floor beam).
- 10" I 25.4 was a slave to 15" I 42.9 (stringer).

All girders, stringers, and floor beams were modeled with beam elements, and the concrete deck was modeled with quadrilateral plate elements with a uniform thickness. Table 5.21 summarizes the optimized parameter results. These results indicate that the optimized parameters (excluding the springs) compare well with the initial parameters. Also, for reference, non-composite and composite section properties corresponding with AASHTO Standard Specifications (4) are also summarized in Table 5.21. Note, the optimized values were limited to a minimum of 80% of the non-composite values to a maximum of 120% of the composite values. The parameters not included in the optimization process are listed in Table 5.22.

Figure 5.15. Bridge #3: Mesh of analytical model and section property names.
Table 5.21. Bridge #3: Adjustable parameters.

<table>
<thead>
<tr>
<th>Section</th>
<th>Property</th>
<th>Units</th>
<th>Non-Composite</th>
<th>Composite</th>
<th>Initial</th>
<th>Optimized</th>
</tr>
</thead>
<tbody>
<tr>
<td>25”8 Beth I 85.5</td>
<td>I_y</td>
<td>in^4</td>
<td>2,600</td>
<td>7,550</td>
<td>7,550</td>
<td>9,050</td>
</tr>
<tr>
<td>27” Beth I 100</td>
<td>I_y</td>
<td>in^4</td>
<td>3,725</td>
<td>10,280</td>
<td>10,280</td>
<td>12,340</td>
</tr>
<tr>
<td>28” Beth I 113</td>
<td>I_y</td>
<td>in^4</td>
<td>4,285</td>
<td>11,440</td>
<td>11,440</td>
<td>13,710</td>
</tr>
<tr>
<td>10” I 25.4</td>
<td>I_y</td>
<td>in^4</td>
<td>122</td>
<td>701</td>
<td>701</td>
<td>840</td>
</tr>
<tr>
<td>15” I 42.9</td>
<td>I_y</td>
<td>in^4</td>
<td>442</td>
<td>1,945</td>
<td>1,945</td>
<td>2,335</td>
</tr>
<tr>
<td>Girder no angle</td>
<td>I_y</td>
<td>in^4</td>
<td>21,360</td>
<td>46,400</td>
<td>46,400</td>
<td>47,350</td>
</tr>
<tr>
<td>Girder no cover</td>
<td>I_y</td>
<td>in^4</td>
<td>26,630</td>
<td>64,490</td>
<td>64,490</td>
<td>77,150</td>
</tr>
<tr>
<td>Girder first cover</td>
<td>I_y</td>
<td>in^4</td>
<td>30,290</td>
<td>76,630</td>
<td>76,630</td>
<td>91,840</td>
</tr>
<tr>
<td>Girder second cover</td>
<td>I_y</td>
<td>in^4</td>
<td>32,070</td>
<td>82,800</td>
<td>82,800</td>
<td>99,230</td>
</tr>
<tr>
<td>Spring (rotational)</td>
<td>K_y</td>
<td>in-k/rad</td>
<td>N/A</td>
<td>N/A</td>
<td>0</td>
<td>7,547,000a</td>
</tr>
<tr>
<td>Deck</td>
<td>E</td>
<td>ksi</td>
<td>N/A</td>
<td>N/A</td>
<td>3,300</td>
<td>3,925</td>
</tr>
</tbody>
</table>

a Corresponds to approximately 40 % fixity.

Table 5.22 Bridge #3: Section properties for non-optimized parameters.

<table>
<thead>
<tr>
<th>Section</th>
<th>Property</th>
<th>Units</th>
<th>Non-Composite</th>
<th>Composite</th>
<th>Fixed value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exterior beam at end</td>
<td>I_y</td>
<td>in^4</td>
<td>122</td>
<td>11,260</td>
<td>1,616*</td>
</tr>
<tr>
<td>Exterior beam at middle</td>
<td>I_y</td>
<td>in^4</td>
<td>442</td>
<td>13,870</td>
<td>1,936*</td>
</tr>
<tr>
<td>End plate 16.0</td>
<td>I_y</td>
<td>in^4</td>
<td>434</td>
<td>N/A</td>
<td>434</td>
</tr>
<tr>
<td>End plate 19.7</td>
<td>I_y</td>
<td>in^4</td>
<td>716</td>
<td>N/A</td>
<td>716</td>
</tr>
<tr>
<td>End plate 23.4</td>
<td>I_y</td>
<td>in^4</td>
<td>1,110</td>
<td>N/A</td>
<td>1,110</td>
</tr>
<tr>
<td>Int plate 18.1</td>
<td>I_y</td>
<td>in^4</td>
<td>710</td>
<td>N/A</td>
<td>710</td>
</tr>
<tr>
<td>Int plate 21.8</td>
<td>I_y</td>
<td>in^4</td>
<td>1,110</td>
<td>N/A</td>
<td>1,110</td>
</tr>
<tr>
<td>Int plate 25.5</td>
<td>I_y</td>
<td>in^4</td>
<td>1,630</td>
<td>N/A</td>
<td>1,630</td>
</tr>
</tbody>
</table>

* Calculated as the sum of steel beam, concrete slab, and curb.

The accuracy of the model is shown graphically in Fig. 5.16 and Fig. 5.17 for various truck paths and various locations and generally indicates that the model predicts the bridge behavior. Table 5.23 summarizes the statistical accuracy and verifies a good correlation since the optimized model has an error of 7.4 % and a correlation coefficient of 0.97. Note, the initial error of 69.4 % can be primarily attributed to the presence of significant end restraint.
a. Location L1 (Girder no angle).

b. Location L3 (Girder first cover).

c. Location L7 (Girder second cover).

Figure 5.16. Bridge #3: Typical strain plots on the girders for truck Path Y1.
Figure 5.17. Bridge #3: Typical strain plots on the stringers and floor beams.

a. Location L12 (Stringer) for truck Path Y3.

b. Location L15 (Floor beam) for truck Path Y4.

c. Location L16 (Floor beam) for truck Path Y4.
Table 5.23 Bridge #3: Model accuracy for initial and optimized model.

<table>
<thead>
<tr>
<th>Error</th>
<th>Units</th>
<th>Initial</th>
<th>Optimized</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Error</td>
<td>microstrain</td>
<td>14,372</td>
<td>4,618</td>
</tr>
<tr>
<td>Percent Error</td>
<td>%</td>
<td>69.4</td>
<td>7.4</td>
</tr>
<tr>
<td>Scale error</td>
<td>%</td>
<td>22.7</td>
<td>9.4</td>
</tr>
<tr>
<td>Correlation coefficient</td>
<td>-</td>
<td>0.87</td>
<td>0.97</td>
</tr>
</tbody>
</table>

The rating model was created by using this optimized model with the appropriate rating trucks and by applying dead load to the structure. Dead load applied to the structure includes the self-weight of all steel sections, the concrete deck, and the concrete curb and parapet. In addition, a 1.89-in. thick overlay was included. For rating purposes, the following truck paths were considered:

- Path A: The passenger side wheel line 2 ft from the North curb.
- Path B: Truck positioned 10 ft to the South of Path A.
- Path C: The driving side wheel line on the second stringer from the North.
- Path D: Truck positioned 10 ft to the South of Path C.

Each path was analyzed at 1 ft intervals in the longitudinal direction. The bridge was designed as a two-lane bridge, so truck path envelopes were created to account for two trucks being on the bridge at the same time (Note: AASHTO Standard Specifications (4) stipulates that the distance between two rating trucks should be 4 ft when used at the same time):

- Envelope 1: Path A combined with Path B.
- Envelope 2: Path C combined with Path D.

Individual member capacities were calculated following appropriate AASHTO Standard Specifications (4). Ratings by the LFD Method (by applying AASHTO Standard Specifications (4)) and by using the BDI Software are presented in Table 5.24 and Table 5.25, respectively. Table 5.26 summarizes the percent difference in inventory ratings between the LFD Method and the BDI Method. The critical rating condition is for shear at 10” I 25.8, which is one of the stringer sections (1.32 by the LFD Method and 1.14 by the BDI Method for a difference of 13.6 %). Note that the large BDI rating values for flexure on the Girder no angle are attributed to small BDI live load moments near the abutment (due to more accurate live load distribution and the end restraint), which results in very large ratings. These ratings will also result in very large percent errors. The relatively large rating factors by the LFD Method for flexure on the girder (i.e., 1.43 at midspan for the HS-20 truck) are due to the angles being included in the calculations (they were determined to be effective based on the experimental results). Furthermore, the large percent difference between BDI Method ratings and
LFD Method ratings are attributed a more accurate load distribution obtained by using the BDI Method. It shall be pointed out that lane loadings were investigated and found to not be critical.

Table 5.24 Bridge #3: Design Truck Rating Factors by the LFD Method.

<table>
<thead>
<tr>
<th>Section</th>
<th>HS-20 Inv. Ope.</th>
<th>HS-20 Inv. Ope.</th>
<th>H-20 Inv. Ope.</th>
<th>Type-3 Inv. Ope.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Beth I 85.5</td>
<td>2.60 4.34 2.11</td>
<td>3.52</td>
<td>2.60 4.34 2.11</td>
<td>3.52</td>
</tr>
<tr>
<td>Beth I 100</td>
<td>2.00 3.34 1.57</td>
<td>2.62</td>
<td>2.28 3.81 1.79</td>
<td>2.99</td>
</tr>
<tr>
<td>Beth I 113</td>
<td>2.03 3.39 1.62</td>
<td>2.70</td>
<td>2.41 4.02 1.93</td>
<td>3.22</td>
</tr>
<tr>
<td>10&quot; I 25.8</td>
<td>2.54 4.24 1.32</td>
<td>2.20</td>
<td>2.54 4.24 1.32</td>
<td>2.20</td>
</tr>
<tr>
<td>15&quot; I 42.9</td>
<td>2.50 4.17 2.23</td>
<td>3.72</td>
<td>2.50 4.17 2.55</td>
<td>4.26</td>
</tr>
<tr>
<td>Girder no angle</td>
<td>2.11 3.52 2.29</td>
<td>3.82</td>
<td>3.40 5.68 3.72</td>
<td>6.21</td>
</tr>
<tr>
<td>Girder no cover</td>
<td>1.85 3.09 2.50</td>
<td>4.17</td>
<td>2.93 4.89 4.02</td>
<td>6.71</td>
</tr>
<tr>
<td>Girder first cover</td>
<td>1.57 2.62 2.88</td>
<td>4.81</td>
<td>2.42 4.04 4.57</td>
<td>7.63</td>
</tr>
<tr>
<td>Girder second cover</td>
<td>1.43 2.39 3.55</td>
<td>5.93</td>
<td>2.19 3.66 5.47</td>
<td>9.13</td>
</tr>
</tbody>
</table>

Table 5.25 Bridge #3: Design Truck Rating Factors by the BDI Method.

<table>
<thead>
<tr>
<th>Section</th>
<th>HS-20 Inv. Ope.</th>
<th>HS-20 Inv. Ope.</th>
<th>H-20 Inv. Ope.</th>
<th>Type-3 Inv. Ope.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Beth I 85.5</td>
<td>2.33 3.89 2.58</td>
<td>4.31</td>
<td>2.42 4.04 2.61</td>
<td>4.36</td>
</tr>
<tr>
<td>Beth I 100</td>
<td>2.45 4.09 3.19</td>
<td>5.32</td>
<td>3.16 5.27 3.76</td>
<td>6.28</td>
</tr>
<tr>
<td>Beth I 113</td>
<td>2.22 3.71 3.21</td>
<td>5.36</td>
<td>3.16 5.27 4.09</td>
<td>6.83</td>
</tr>
<tr>
<td>10&quot; I 25.8</td>
<td>4.27 7.13 1.14</td>
<td>1.90</td>
<td>4.27 7.13 1.14</td>
<td>1.90</td>
</tr>
<tr>
<td>15&quot; I 42.9</td>
<td>3.60 6.01 3.68</td>
<td>6.14</td>
<td>3.59 5.99 4.03</td>
<td>6.73</td>
</tr>
<tr>
<td>Girder no angle</td>
<td>24.89 41.55 2.54</td>
<td>4.24</td>
<td>24.89 41.55 4.11</td>
<td>6.86</td>
</tr>
<tr>
<td>Girder no cover</td>
<td>5.90 9.85 2.63</td>
<td>4.39</td>
<td>8.92 14.89 4.25</td>
<td>7.09</td>
</tr>
<tr>
<td>Girder first cover</td>
<td>4.23 7.06 4.09</td>
<td>6.83</td>
<td>6.46 10.78 6.42</td>
<td>10.72</td>
</tr>
<tr>
<td>Girder second cover</td>
<td>3.75 6.26 4.60</td>
<td>7.68</td>
<td>5.63 9.40 6.96</td>
<td>11.62</td>
</tr>
</tbody>
</table>

\* Edge stiffening included in the analytical model.
Table 5.26  Bridge #3: Percent difference in Design Truck Rating Factors between LFD Method and BDI Software.

<table>
<thead>
<tr>
<th>Section</th>
<th>Flexure</th>
<th>Shear</th>
<th>Flexure</th>
<th>Shear</th>
<th>Flexure</th>
<th>Shear</th>
</tr>
</thead>
<tbody>
<tr>
<td>Beth I 85.5</td>
<td>-10.4</td>
<td>22.3</td>
<td>-6.9</td>
<td>23.7</td>
<td>-12.3</td>
<td>25.2</td>
</tr>
<tr>
<td>Beth I 100</td>
<td>22.5</td>
<td>103.2</td>
<td>38.6</td>
<td>110.1</td>
<td>20.8</td>
<td>96.5</td>
</tr>
<tr>
<td>Beth I 113</td>
<td>9.4</td>
<td>98.1</td>
<td>31.1</td>
<td>111.9</td>
<td>18.0</td>
<td>104.5</td>
</tr>
<tr>
<td>10&quot; I 25.8</td>
<td>68.1</td>
<td>-13.6</td>
<td>68.1</td>
<td>-13.6</td>
<td>22.1</td>
<td>33.1</td>
</tr>
<tr>
<td>15&quot; I 42.9</td>
<td>44.0</td>
<td>65.0</td>
<td>43.6</td>
<td>58.0</td>
<td>36.7</td>
<td>56.7</td>
</tr>
<tr>
<td>Girder no angle</td>
<td>1079.6a</td>
<td>10.9</td>
<td>632.1a</td>
<td>10.5</td>
<td>922.4a</td>
<td>9.7</td>
</tr>
<tr>
<td>Girder no cover</td>
<td>218.9b</td>
<td>5.2</td>
<td>204.4b</td>
<td>5.7</td>
<td>209.8b</td>
<td>4.0</td>
</tr>
<tr>
<td>Girder first cover</td>
<td>169.4b</td>
<td>42.0</td>
<td>166.9b</td>
<td>40.5</td>
<td>166.2b</td>
<td>39.5</td>
</tr>
<tr>
<td>Girder second cover</td>
<td>162.2b</td>
<td>29.6</td>
<td>157.1b</td>
<td>27.2</td>
<td>157.7b</td>
<td>25.9</td>
</tr>
</tbody>
</table>

* Large percent difference due to small BDI live load moments and more accurate load distribution.
* Large percent difference due to more accurate load distribution.

5.5.  BRIDGE #4

As previously mentioned, it was predicted that the bridge would not exhibit significant end restraint as the beams are not integral with the abutments. Typical experimental data on the girder near the abutment as shown in Fig. 5.18a indicates that there is some end restraint; however it is small as both flanges (top and bottom) are in compression when the truck is near the abutments and both flanges are in tension when the truck is away from the abutments. Further, since both flanges are in tension or in compression at the same time as shown in Fig. 5.18a, this indicates that the neutral axis is located near the top flange, which verifies the presence of composite action near the abutment.

Experimental data for the girder section at midspan, illustrated in Fig. 5.18b, indicate that the neutral axis location is above the top flange, hence composite action and edge stiffening are verified for the girder section at midspan. These results are typical for all spans. Further, typical experimental data for the girder section near the piers (illustrated in Fig. 5.19c) show that the neutral axis is located near the top flange indicating the presence of composite action (even though it was not expected) at these sections. Typical data illustrated in Figure 5.18c also indicate that the bottom flange near Pier 1 is in compression, hence there is a negative moment region near the piers. Moreover, typical experimental data for a floor beam at midspan (shown in Fig. 5.19a) and near the girder (shown in Fig. 5.19b) indicate composite action since the neutral axis locations at both locations are near the top flanges. Experimental strains are presented in Fig. 5.19c to verify transverse symmetry. Strain symmetry in
a. Strains near the South abutment at Location L2.

b. Strains at midspan at Location L4.

c. Strains near Pier 1 at Location L6.

Figure 5.18. Bridge #4: Experimental data on the girders for Path Y1.
a. Strains at midspan on a floor beam at Location L15 for Path Y3.

b. Strains near the girder on a floor beam at Location L16 for Path Y3.

c. Transverse strain symmetry.

Figure 5.19. Experimental data on a floor beam and transverse strain symmetry.
the longitudinal direction was not possible to verify since gages were only installed for one half of the bridge. Strains were assumed to be symmetric since the bridge is symmetric about the bridge centerline, bearing conditions at both abutments are the same, and all structural elements appear to be in good condition.

Based on the initial review of the data briefly discussed in the previous paragraph, an analytical model was created using 4 elements in the transverse direction and 50 elements in the longitudinal direction (shown in Fig. 5.20). Rotational springs were included for the girders at the centerline of the abutment bearings. As a result of the experimental data indicating that both the girders and the floor beams behave compositely with the deck, all steel sections were modeled as composite beams in the analytical model. The girders and floor beams were modeled with beam elements, and the concrete deck was modeled with quadrilateral plate elements. Table 5.27 summarizes the optimized parameter results. These results indicate that all optimized parameters (excluding the springs) compare well with the initial parameters.

![Bridge #4: Mesh of the analytical model for one half of the bridge.](image)

The accuracy of the generated model is shown graphically in Fig. 5.21 and Fig. 5.22 for typical data at various locations and various paths, where Fig. 5.21 illustrates typical strains on the South girder, and Fig. 5.22 presents typical strains in one of the girders at Locations L10 and L12 and in one of the floor beams at Location L15. All results compare well and indicate that the model accurately predicts the bridge behavior. Table 5.28 summarizes the statistical accuracy and verifies a good correlation. The initial model assuming simply supported conditions returned an error of 10.4 % and a correlation
Figure 5.21. Bridge #4: Typical strains on the South girder for truck Path Y1.
a. Strains near Pier 2 at Location L10 for Path Y1.

b. Strains near Pier 2 at Location L12 for Path Y1.

c. Strains at midspan for the floor beam at Location L15 for Path Y3.

Figure 5.22. Bridge #4: Typical strain plots for truck Paths Y1 and Y3.
coefficient of 0.95; with the final model, the error was reduced to 4.0 % and had a correlation coefficient of 0.98. These results verify the good correlation between the experimental and analytical data.

Table 5.27. Bridge #4: Adjustable parameters.

<table>
<thead>
<tr>
<th>Section</th>
<th>Property</th>
<th>Units</th>
<th>Non-Composite</th>
<th>Composite</th>
<th>Initial</th>
<th>Optimized</th>
</tr>
</thead>
<tbody>
<tr>
<td>Girder at first span</td>
<td>I_y</td>
<td>in^4</td>
<td>5,155</td>
<td>21,630</td>
<td>21,630</td>
<td>25,030</td>
</tr>
<tr>
<td>Girder at second span</td>
<td>I_y</td>
<td>in^4</td>
<td>5,155</td>
<td>21,630</td>
<td>21,630</td>
<td>24,190</td>
</tr>
<tr>
<td>Girder near first pier</td>
<td>I_y</td>
<td>in^4</td>
<td>11,300</td>
<td>35,770</td>
<td>35,770</td>
<td>37,260</td>
</tr>
<tr>
<td>Girder near second pier</td>
<td>I_y</td>
<td>in^4</td>
<td>12,410</td>
<td>37,330</td>
<td>37,330</td>
<td>44,770</td>
</tr>
<tr>
<td>Floor beam</td>
<td>I_y</td>
<td>in^4</td>
<td>1,085</td>
<td>3,905</td>
<td>3,905</td>
<td>4,755</td>
</tr>
<tr>
<td>Concrete Deck</td>
<td>E</td>
<td>ksi</td>
<td>N/A</td>
<td>3,600</td>
<td>3,600</td>
<td>2,885</td>
</tr>
<tr>
<td>Spring (rotational)</td>
<td>K_y</td>
<td>in-k/rad</td>
<td>N/A</td>
<td>N/A</td>
<td>0</td>
<td>3,455,000</td>
</tr>
</tbody>
</table>

*Corresponds to approximately 30 % fixity.

Table 5.28. Bridge #4: Model accuracy for initial and optimized model.

<table>
<thead>
<tr>
<th>Statistical Term</th>
<th>Units</th>
<th>Initial</th>
<th>Optimized</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total error</td>
<td>microstrain</td>
<td>8,301</td>
<td>5,974</td>
</tr>
<tr>
<td>Percent Error</td>
<td>%</td>
<td>10.4</td>
<td>4.0</td>
</tr>
<tr>
<td>Scale Error</td>
<td>%</td>
<td>5.4</td>
<td>5.1</td>
</tr>
<tr>
<td>Correlation Coefficient</td>
<td>N/A</td>
<td>0.95</td>
<td>0.98</td>
</tr>
</tbody>
</table>

The rating model was then created using this optimized model with the appropriate rating trucks instead of the field truck and by applying the structure selfweight (i.e., dead load included the self-weight of all steel sections, the concrete deck, and the concrete curb). For rating purposes, the following truck positions (for the HS-20, H-20, and Type-3 trucks) were considered:

- Path A: The passenger side wheel line was 2 ft from East curb.
- Path B: Truck positioned 10 ft West of Path A.
- Path C: The driving side wheel line placed on the bridge centerline.
- Path D: The truck was positioned 10 ft West of Path B.
- Path E: The driving side wheel line was 2 ft East of the bridge centerline.
- Path F: The passenger side wheel line was 2 ft West of the bridge centerline.
Each path was analyzed at 1 ft intervals. This bridge was designed as a two-lane bridge, so truck path envelopes were created for two trucks being on the bridge at the same time (Note: AASHTO Standard Specifications (4) stipulates that the distance between two rating trucks should be 4 ft when they are both on the bridge):

- Envelope 1: Path A combined with Path B.
- Envelope 2: Path C combined with Path D.
- Envelope 3: Path E combined with Path F.

Individual member capacities were calculated following appropriate AASHTO Standard Specifications (4). Ratings by the LFD Method (by applying AASHTO Standard Specifications (4)) and by using the BDI Software are presented in Table 5.29 and Table 5.30, respectively. Table 5.31 summarizes the percent difference between Inventory Ratings obtained using the LFD Method and the Inventory Ratings obtained using the BDI Software. The critical rating condition is for flexure in the girder near the second pier (0.78 by the LFD Method and 1.38 by the BDI Software for a difference of 76.9%). However, the critical rating condition for flexure in the floor beam by applying the BDI Software is 0.82 by the BDI Method and 0.83 by the LFD Method. The lane loadings investigated were determined not to be critical. Also, the HS-20 (30) rating truck used in the analytical rating model, was determined not to be critical (as previously mentioned, HS-20 (30) is the same truck as HS-20 but with a different distance between the rear axles).

Table 5.29. Bridge #4: Design Truck Rating Factors by the LFD Method.

<table>
<thead>
<tr>
<th></th>
<th>HS-20</th>
<th>H-20</th>
<th>Type-3</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Flexure</td>
<td>Shear</td>
<td>Flexure</td>
</tr>
<tr>
<td>Girder at first span</td>
<td>1.05</td>
<td>1.75</td>
<td>1.41</td>
</tr>
<tr>
<td>Girder at second span</td>
<td>0.88</td>
<td>1.48</td>
<td>N/A</td>
</tr>
<tr>
<td>Girder near first pier</td>
<td>0.83</td>
<td>1.38</td>
<td>0.82</td>
</tr>
<tr>
<td>Girder near second pier</td>
<td>0.78</td>
<td>1.30</td>
<td>0.87</td>
</tr>
<tr>
<td>Floor beam</td>
<td>0.83</td>
<td>1.39</td>
<td>1.02</td>
</tr>
</tbody>
</table>

5.6. BRIDGE #5

For the typical experimental data shown in Fig. 5.23, Bridge #5 exhibits significant end restraint because the bottom flanges on the girder near the abutment (shown in Fig. 5.23a) are in
a. Strains near the abutment for an interior girder at Location L12.

b. Strains at midspan for an interior girder at Location L11.

c. Strains at midspan for an exterior girder at Location L14.

Figure 5.23. Bridge #5: Typical experimental strains for Path Y1.
Table 5.30. Bridge #4: Design Truck Rating Factors by the BDI Method.

<table>
<thead>
<tr>
<th>Section</th>
<th>HS-20 Flexure Inv.</th>
<th>HS-20 Shear Ope.</th>
<th>H-20 Flexure Inv.</th>
<th>H-20 Shear Ope.</th>
<th>Type-3 Flexure Inv.</th>
<th>Type-3 Shear Ope.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Girder at first span</td>
<td>1.36</td>
<td>2.27</td>
<td>2.13</td>
<td>3.17</td>
<td>1.90</td>
<td>3.17</td>
</tr>
<tr>
<td>Girder at second span</td>
<td>0.88</td>
<td>1.47</td>
<td>N/A</td>
<td>N/A</td>
<td>1.28</td>
<td>2.14</td>
</tr>
<tr>
<td>Girder near first pier</td>
<td>1.36</td>
<td>2.27</td>
<td>1.31</td>
<td>2.19</td>
<td>2.25</td>
<td>3.76</td>
</tr>
<tr>
<td>Girder near second pier</td>
<td>1.38</td>
<td>2.30</td>
<td>1.36</td>
<td>2.27</td>
<td>2.29</td>
<td>3.82</td>
</tr>
<tr>
<td>Floor beam</td>
<td>0.82</td>
<td>1.37</td>
<td>1.90</td>
<td>3.17</td>
<td>1.06</td>
<td>1.77</td>
</tr>
</tbody>
</table>

Table 5.31. Bridge #4: Percent difference in Design Truck Rating Factors between LFD Method and BDI Software.

<table>
<thead>
<tr>
<th>Section</th>
<th>HS-20 Flexure</th>
<th>HS-20 Shear</th>
<th>H-20 Flexure</th>
<th>H-20 Shear</th>
<th>Type-3 Flexure</th>
<th>Type-3 Shear</th>
</tr>
</thead>
<tbody>
<tr>
<td>Girder at first span</td>
<td>33.3</td>
<td>0.0</td>
<td>38.7</td>
<td>4.3</td>
<td>40.6</td>
<td>0.5</td>
</tr>
<tr>
<td>Girder at second span</td>
<td>0.0</td>
<td>N/A</td>
<td>4.1</td>
<td>N/A</td>
<td>1.7</td>
<td>N/A</td>
</tr>
<tr>
<td>Girder near first pier</td>
<td>63.9</td>
<td>59.8</td>
<td>74.4</td>
<td>59.7</td>
<td>77.6</td>
<td>60.5</td>
</tr>
<tr>
<td>Girder near second pier</td>
<td>76.9</td>
<td>56.3</td>
<td>72.2</td>
<td>58.6</td>
<td>74.8</td>
<td>57.0</td>
</tr>
<tr>
<td>Floor beam</td>
<td>-1.2</td>
<td>86.3</td>
<td>-1.9</td>
<td>74.0</td>
<td>0.0</td>
<td>88.5</td>
</tr>
</tbody>
</table>

compression. The neutral axis at this location varies from mid-depth of the steel-section to the top flange. Experimental data at midspan for an interior girder presented in Fig. 5.23b indicate composite action since the neutral axis location is near the top flange. Furthermore, as shown in Fig. 5.23c, experimental data at midspan for an exterior girder indicate that the neutral axis location lies well above the top flange since the top flange is in tension, hence composite action and edge stiffening due to the curb are verified. Moreover, experimental strains presented in Figs. 5.24b and 5.24c verify transverse and longitudinal strain symmetry (Note: Longitudinal strain symmetry is difficult to verify due to the unidirectional movement of the load truck).

Based on the initial review of the data briefly discussed in the previous paragraph, an analytical model was created as shown in Fig. 5.25 with two elements between each girder and twelve elements in the longitudinal direction. Rotational springs were included for all girders at the centerline of the abutment bearings. As a result of the experimental data indicating composite
a. Strains near the abutment for an exterior girder at Location L15 for Path Y1.

b. Strain symmetry in the transverse direction

c. Strain symmetry in the longitudinal direction

Figure 5.24. Bridge #5: Typical experimental strains and symmetry plots.
behavior at midspan, all girder sections at midspan were modeled as composite beams and all girder sections near the abutment were modeled as non-composite. In addition, the curb was included for the exterior beams at midspan to account for edge stiffening (as indicated in the previous paragraph). The girders were modeled with beam elements, and the concrete deck was modeled with quadrilateral plate elements. Table 5.32 summarizes the optimized parameter results. These results indicate that all optimized parameters (excluding the springs) compare well with the initial parameters.

Table 5.32. Bridge #5: Adjustable parameters.

<table>
<thead>
<tr>
<th>Section</th>
<th>Property</th>
<th>Units</th>
<th>Non-Composite</th>
<th>Composite</th>
<th>Initial</th>
<th>Optimized</th>
</tr>
</thead>
<tbody>
<tr>
<td>New ext. girder near abut.</td>
<td>$I_y$</td>
<td>in$^4$</td>
<td>800</td>
<td>14,415</td>
<td>800</td>
<td>1,160</td>
</tr>
<tr>
<td>New ext. girder at midspan</td>
<td>$I_y$</td>
<td>in$^4$</td>
<td>800</td>
<td>14,415</td>
<td>14,415</td>
<td>11,720</td>
</tr>
<tr>
<td>Old ext. girder near abut.</td>
<td>$I_y$</td>
<td>in$^4$</td>
<td>736</td>
<td>13,835</td>
<td>736</td>
<td>1,160</td>
</tr>
<tr>
<td>Old ext. girder at midspan</td>
<td>$I_y$</td>
<td>in$^4$</td>
<td>736</td>
<td>13,835</td>
<td>13,835</td>
<td>11,500</td>
</tr>
<tr>
<td>Int. girder near abut.</td>
<td>$I_y$</td>
<td>in$^4$</td>
<td>736</td>
<td>3,005</td>
<td>736</td>
<td>1,255</td>
</tr>
<tr>
<td>Int. girder at midspan</td>
<td>$I_y$</td>
<td>in$^4$</td>
<td>736</td>
<td>3,005</td>
<td>3,005</td>
<td>3,595</td>
</tr>
<tr>
<td>Deck</td>
<td>$E$</td>
<td>ksi</td>
<td>N/A</td>
<td>N/A</td>
<td>3,600</td>
<td>4,990</td>
</tr>
<tr>
<td>Spring (rotational)</td>
<td>$K_y$</td>
<td>in-k/rad</td>
<td>N/A</td>
<td>N/A</td>
<td>0</td>
<td>944,000$^a$</td>
</tr>
</tbody>
</table>

$^a$ Corresponds to approximately 20% fixity.
The accuracy of the generated model is shown graphically in Fig. 5.26 and Fig. 5.27 where Fig. 5.26 illustrates typical strains for the interior girders using Path Y1, and Fig. 5.26 presents typical strains for the exterior girders. Generally, all results compare well, and Table 5.33 illustrates the model accuracies for the initial and optimized models. Initially, assuming simply supported condition and initial section property values, an error of 164.5 % and a correlation coefficient of 0.79 were obtained. These values do not represent a good correlation between the measured and calculated strains, but the reason for the poor correlation is primarily due to the end restraint. The optimized model results in an error of 6.6 % and a correlation coefficient of 0.97, which verifies the good correlation between experimental and optimized analytical strains.

<table>
<thead>
<tr>
<th>Statistical Term</th>
<th>Units</th>
<th>Initial</th>
<th>Optimized</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total error</td>
<td>microstrain</td>
<td>3,525</td>
<td>770</td>
</tr>
<tr>
<td>Percent Error</td>
<td>%</td>
<td>164.5</td>
<td>6.6</td>
</tr>
<tr>
<td>Scale Error</td>
<td>%</td>
<td>81.0</td>
<td>8.4</td>
</tr>
<tr>
<td>Correlation Coefficient</td>
<td>N/A</td>
<td>0.79</td>
<td>0.97</td>
</tr>
</tbody>
</table>

By using this optimized model with the appropriate rating trucks instead of the field truck and by applying dead load to the structure, the rating model was created. Dead load applied on the structure includes the self-weight of the girders, concrete deck including the overlay, and the concrete curb. For rating purposes, appropriate design trucks were considered:

- Paths A and B: The outer wheel line two ft from each curb.
- Path C: The driving side wheel line on the West interior girder.
- Path D: The driving side wheel line on the center girder.
- Path E: The truck placed on the bridge centerline.

Each path was analyzed at 1 ft intervals. The bridge was designed as a single-lane bridge, so no truck path combinations were created. Individual member capacities were calculated following appropriate AASHTO Standard Specifications (4). Table 5.34 and Table 5.35 show the ratings by the LFD Method (by applying AASHTO Standard Specifications (4)) and by using the BDI Software, respectively. Table 5.36 summarizes the percent difference between inventory ratings by the LFD Method and by using the BDI Software. The critical rating condition is for flexure on the interior girder at midspan (0.87 by the LFD Method and 1.38 by the BDI Method for a difference of 92.0%).
Figure 5.26. Bridge #5: Typical strain plots for interior girders for truck Path Y1.
Figure 5.27. Bridge #5: Typical strain plots for the exterior girders.
Some of the BDI Software rating values were less than the LFD Method values; however, all values are above 1.0 where this occurs. It shall be pointed out that the lane loadings were investigated, but were found to be not critical. Also, a negative percent difference in Table 5.36 indicates that the BDI rating are lower than the LFD rating.

Table 5.34. Bridge #5: Design Truck Rating Factors by the LFD Method.

<table>
<thead>
<tr>
<th>Section</th>
<th>HS-20 Flexure</th>
<th>HS-20 Shear</th>
<th>H-20 Flexure</th>
<th>H-20 Shear</th>
<th>Type-3 Flexure</th>
<th>Type-3 Shear</th>
</tr>
</thead>
<tbody>
<tr>
<td>New exterior girder</td>
<td>1.35</td>
<td>2.25</td>
<td>2.90</td>
<td>4.85</td>
<td>1.35</td>
<td>2.25</td>
</tr>
<tr>
<td>Old exterior girder</td>
<td>1.51</td>
<td>2.53</td>
<td>3.51</td>
<td>5.86</td>
<td>1.51</td>
<td>2.53</td>
</tr>
<tr>
<td>Interior girder</td>
<td>0.87</td>
<td>1.45</td>
<td>2.06</td>
<td>3.43</td>
<td>0.87</td>
<td>1.45</td>
</tr>
</tbody>
</table>

Table 5.35. Bridge #5: Design Truck Rating Factors by the BDI Method.

<table>
<thead>
<tr>
<th>Section</th>
<th>HS-20 Flexure</th>
<th>HS-20 Shear</th>
<th>H-20 Flexure</th>
<th>H-20 Shear</th>
<th>Type-3 Flexure</th>
<th>Type-3 Shear</th>
</tr>
</thead>
<tbody>
<tr>
<td>New exterior girder</td>
<td>1.23</td>
<td>2.05</td>
<td>3.03</td>
<td>5.06</td>
<td>1.24</td>
<td>2.07</td>
</tr>
<tr>
<td>Old exterior girder</td>
<td>1.30</td>
<td>2.17</td>
<td>3.56</td>
<td>5.94</td>
<td>1.30</td>
<td>2.17</td>
</tr>
<tr>
<td>Interior girder</td>
<td>1.67</td>
<td>2.79</td>
<td>2.97</td>
<td>4.96</td>
<td>1.68</td>
<td>2.80</td>
</tr>
</tbody>
</table>

*Unintended composite action included.*

Table 5.36. Bridge #5: Percent difference in Design Truck Rating Factors between LFD Method and BDI Software.

<table>
<thead>
<tr>
<th>Section</th>
<th>HS-20 Flexure</th>
<th>HS-20 Shear</th>
<th>H-20 Flexure</th>
<th>H-20 Shear</th>
<th>Type-3 Flexure</th>
<th>Type-3 Shear</th>
</tr>
</thead>
<tbody>
<tr>
<td>New exterior girder</td>
<td>-8.9</td>
<td>4.5</td>
<td>-8.1</td>
<td>2.9</td>
<td>-6.7</td>
<td>12.1</td>
</tr>
<tr>
<td>Old exterior girder</td>
<td>-13.9</td>
<td>1.4</td>
<td>-13.9</td>
<td>0.9</td>
<td>-13.7</td>
<td>5.2</td>
</tr>
<tr>
<td>Interior girder</td>
<td>92.0</td>
<td>44.2</td>
<td>93.1</td>
<td>34.4</td>
<td>109.3</td>
<td>49.6</td>
</tr>
</tbody>
</table>
5.7. BRIDGE #6

As mentioned previously, it was anticipated that the bridge would exhibit significant end restraint since there are no abutment deck expansion joints. Typical experimental data are presented in Fig 5.28, where Fig. 5.28a illustrates typical strains for Path Y2, Fig. 5.28b shows typical strains for Path Y3, and Fig. 5.28c illustrates typical strains for Path Y4. Figure 5.28b and Fig. 5.28c show that the gages on the bottom of the slab near the abutments are in compression when the truck is near; hence end restraint is verified (note that no gages were placed on top of the slab, which makes it difficult to identify negative moments near the abutments). Experimental data illustrating symmetry are shown in Fig. 5.30, where Fig. 5.30a and Fig. 5.30b illustrate that the strains are non-symmetric in the transverse direction since the strain peaks are not of the same magnitudes, and Fig. 5.30c verifies that the strain is symmetric in the longitudinal direction since the strain magnitudes are approximately the same.

Based on the initial review of the data briefly discussed in the previous paragraph, two different sections were created for the curb (i.e., one section on the West edge and one section on the East edge) to account for the non-symmetric edge stiffness. As shown in Fig. 5.31, ten elements were created in the longitudinal direction and twenty elements were created in the transverse direction to obtain square plate elements. Rotational springs were included at the centerline of the abutment bearings on every second mesh-line to account for the end restraint. The deck was modeled with quadrilateral plate elements. Table 5.37 summarizes the optimized parameter results.

Table 5.37. Bridge #6: Adjustable parameters.

<table>
<thead>
<tr>
<th>Section</th>
<th>Property</th>
<th>Units</th>
<th>Non-Composite</th>
<th>Composite</th>
<th>Initial</th>
<th>Optimized</th>
</tr>
</thead>
<tbody>
<tr>
<td>Curb West</td>
<td>$I_y$</td>
<td>in$^4$</td>
<td>N/A</td>
<td>29,850</td>
<td>29,850</td>
<td>71,140</td>
</tr>
<tr>
<td>Curb East</td>
<td>$I_y$</td>
<td>in$^4$</td>
<td>N/A</td>
<td>29,850</td>
<td>29,850</td>
<td>5,195</td>
</tr>
<tr>
<td>Deck</td>
<td>E</td>
<td>ksi</td>
<td>N/A</td>
<td>N/A</td>
<td>3,600</td>
<td>5,985</td>
</tr>
<tr>
<td>Spring (rotational)</td>
<td>$K_y$</td>
<td>in-k/rad</td>
<td>N/A</td>
<td>N/A</td>
<td>0</td>
<td>534,210$^a$</td>
</tr>
</tbody>
</table>

$^a$ Corresponds to approximately 40 % fixity.

The accuracy of the generated model is shown graphically in Fig. 5.31 through Fig. 5.33 for typical data at various locations and various truck paths. All figures illustrate that the optimized analytical strains correlate relatively well with the experimental strains; however, the optimized parameters for West and East curb do not correlate very well with the initial parameters. The reason they do not correlate that well is because it was not possible to locate the neutral axis on the East
a. Strains for Path Y2.

b. Strains for Path Y3.

c. Strains for Path Y4.

Figure 5.28. Bridge #6: Typical experimental strains.
a. Non-symmetric strains near the abutments in the transverse direction.

b. Non-symmetric strains at midspan in the transverse direction.

c. Longitudinal symmetry for Path Y3 (strains on the bottom of the slab).

Figure 5.29. Bridge #6: Experimental strains and strain symmetry.
Curb without any strain data on top of the curb (strain gages on top of the curb were only installed on the West edge). Even though two different sections were created, and two different inertia values were obtained, the optimized value for the East Curb is of little use since the location of the neutral axis could not be established. However, it was necessary to include the two sections in the optimization process to obtain a reasonable analytical bridge model. Table 5.38 illustrates the model accuracy and shows that the initial error of 131.4 % and a correlation coefficient of 0.88 indicate a poor correlation between the experimental and analytical strains due to end restraint and non-symmetric behavior. However, the optimized model shows a final error of 9.9 % and a correlation coefficient of 0.95. These results indicate a relatively good correlation between the experimental and the optimized analytical strains (note that strains on a concrete slab are more difficult to predict than strains on a steel member).
Figure 5.31. Bridge #6: Strain plots at the West Curb for truck Path Y1.

a. Location L1.

b. Location L2.

c. Location L3.
Figure 5.32. Bridge #6: Typical strains on the bottom of the slab for truck Paths Y2 and Y3.

- a. Location L5 for truck Path Y2.
- b. Location L14 for truck Path Y3.
- c. Location L15 for truck Path Y3.
a. Location L17.

b. Location L18.

c. Location L20.

Figure 5.33. Bridge #6: Typical strain plots at the bottom of slab for truck Path Y4.
Table 5.38. Bridge #6: Model accuracy for initial and optimized model.

<table>
<thead>
<tr>
<th>Statistical Term</th>
<th>Units</th>
<th>Initial</th>
<th>Optimized</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total error</td>
<td>microstrain</td>
<td>1,649</td>
<td>450</td>
</tr>
<tr>
<td>Percent Error</td>
<td>%</td>
<td>131.4</td>
<td>9.9</td>
</tr>
<tr>
<td>Scale Error</td>
<td>%</td>
<td>31.6</td>
<td>4.9</td>
</tr>
<tr>
<td>Correlation Coefficient</td>
<td>N/A</td>
<td>0.88</td>
<td>0.95</td>
</tr>
</tbody>
</table>

By using this optimized model with the appropriate rating trucks instead of the field truck and by applying dead load to the structure, the rating model was created. Dead load applied in the analytical model includes the self-weight of the concrete slab deck and the concrete curb, and an additional 2.38 ft fill and asphalt overlay on top of the deck. For rating purposes, appropriate design trucks were considered:

- Path A: The driver side wheel line 7 ft from the East curb.
- Path B: The driver side wheel line 12 ft from the East curb.
- Path C: The driver side wheel line 17 ft from the East curb.
- Path D: The driver side wheel line 22 ft from the East curb.
- Path E: The driver side wheel line 27 ft from the East curb.
- Path F: The driver side wheel line 32 ft from the East curb.
- Path G: The driver side wheel line 1 ft from the West curb.
- Path H: The driver side wheel line 11 ft from the West curb.

Each path was analyzed at 1 ft intervals. This bridge was designed as a two-lane bridge, so truck path envelopes were created to account for two trucks being on the bridge at the same time:

- Envelope 1: Path A combined with Path C.
- Envelope 2: Path B combined with Path D.
- Envelope 3: Path C combined with Path E.
- Envelope 4: Path D combined with Path F.
- Envelope 5: Path G combined with Path H.

Individual member capacities were calculated following appropriate AASHTO Standard Specifications (4). Table 5.39 and Table 5.40 show the ratings by the LFD Method (by applying AASHTO Standard Specifications (4)) and by using the BDI Software, respectively. Table 5.42 summarizes the percent difference between inventory ratings by the LFD Method and by using the BDI Software (note: a positive percent difference indicates that the BDI rating value is greater than
the LFD rating value). The critical rating condition is 0.67 by The LFD Method and 1.55 by the BDI Software for a difference of 131.3%. It shall be pointed out that lane loadings were investigated and were found to be not critical.

Table 5.39. Bridge #6: Design Truck Rating Factors by The LFD Method.

<table>
<thead>
<tr>
<th>Section</th>
<th>HS-20</th>
<th>H-20</th>
<th>Type-3</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Flexure</td>
<td>Shear</td>
<td>Flexure</td>
</tr>
<tr>
<td>Deck</td>
<td>0.67</td>
<td>1.12</td>
<td>1.86</td>
</tr>
</tbody>
</table>

Table 5.40. Bridge #6: Design Truck Rating Factors by the BDI Methoda.

<table>
<thead>
<tr>
<th>Section</th>
<th>HS-20</th>
<th>H-20</th>
<th>Type-3</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Flexure</td>
<td>Shear</td>
<td>Flexure</td>
</tr>
<tr>
<td>Deck</td>
<td>1.55</td>
<td>2.59</td>
<td>1.79</td>
</tr>
</tbody>
</table>

a Edge stiffening included.

Table 5.41. Bridge #6: Percent difference in Design Truck Rating Factors between LFD Method and BDI Software.

<table>
<thead>
<tr>
<th>Section</th>
<th>HS-20</th>
<th>H-20</th>
<th>Type-3</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Flexure</td>
<td>Shear</td>
<td>Flexure</td>
</tr>
<tr>
<td>Deck</td>
<td>131.3</td>
<td>-3.8</td>
<td>131.3</td>
</tr>
</tbody>
</table>

5.8. BRIDGE #7

Typical experimental data are presented in Figs. 5.34 through 5.36, where Fig. 5.34a indicate that edge stiffening due to the curb occurs since the neutral axis location is above mid depth of the slab. As described previously, gages were installed near the construction joint for Path Y2 to observe the potential live load transfer across the joint. Experimental data at midspan near the construction joint are presented in Fig. 5.35, where Fig 5.35a illustrates the strains 5 ft West of the joint, the strains 1 ft West of the joint are shown in Fig. 5.35b, and the strains 1 ft East of the joint are shown in Fig. 5.35c. These results indicate that the loads are not transferred linearly across the joint since, because, if the loads were transferred linearly, the strains in Fig. 5.35c should have been larger relative to the
a. Strains at midspan at Location L2.

b. Strains near the abutment at Location L1.

c. Strains on the bottom of the slab at locations L7 and L8.

Figure 5.34. Bridge #7: Typical experimental strains for Path Y4.
a. Strains 5 ft West of construction joint at Location L14.

b. Strains 1 ft West of construction joint at Location L17.

c. Strains 1 ft East of construction joint at Location L20.

Figure 5.35. Bridge #7: Experimental strains at midspan near the construction joint for Path Y2.
a. Strains on the bottom of the slab across the construction joint for Path Y2.

b. Transverse strain symmetry.

c. Strain comparison to identify longitudinal strain symmetry.

Figure 5.36. Bridge #7: Experimental strains and strain symmetry.
strains shown in Fig. 5.35b. Figure 5.36a illustrates the strain transfer across the joint on the bottom of the slab near the abutment for Path Y2, and verifies that the strains are not linearly transferred across the joint. Further, as can be seen in Fig. 5.36b, the strains are relatively symmetric in the transverse direction since the strain magnitudes are approximately the same, and Fig. 5.36c shows that the strains are also relatively symmetric in the longitudinal direction since the strain peaks are approximately of the same magnitudes.

Based on the initial review of the data briefly discussed in the previous paragraph, the curb was included in the analytical model to account for the edge stiffening. It was not possible to take into account the fact that strains did not transfer linearly across the construction joint due to the limitations of the BDI Software, so, in the analytical model, strains will transfer linearly across the joint. As shown in Fig. 5.37, twelve elements were created in the longitudinal direction and fifteen elements were created in the transverse direction. Rotational springs were included at the centerline of the abutment bearings on every second analytical mesh-line to account for the end restraint (note: the BDI Software has a limited number of springs that can be included in the model, and, for this bridge model, the software would not run if springs were included on all mesh-lines). The deck was modeled with quadrilateral plate elements. Table 5.42 summarizes the optimized parameter results.

Figure 5.37. Bridge #7: Mesh of the analytical model with section property names.
Table 5.42. Bridge #7: Adjustable parameters.

<table>
<thead>
<tr>
<th>Section</th>
<th>Property</th>
<th>Units</th>
<th>Non-Composite</th>
<th>Composite</th>
<th>Initial</th>
<th>Optimized</th>
</tr>
</thead>
<tbody>
<tr>
<td>Curb</td>
<td>$I_y$</td>
<td>in$^4$</td>
<td>N/A</td>
<td>183,460</td>
<td>183,460</td>
<td>348,700</td>
</tr>
<tr>
<td>Deck</td>
<td>E</td>
<td>ksi</td>
<td>N/A</td>
<td>N/A</td>
<td>3,600</td>
<td>3,960</td>
</tr>
<tr>
<td>Spring (rotational)</td>
<td>$K_y$</td>
<td>in-k/rad</td>
<td>N/A</td>
<td>N/A</td>
<td>0</td>
<td>39,670$^a$</td>
</tr>
</tbody>
</table>

$^a$ Correlates to approximate 5% fixity.

The accuracy of the generated model is shown graphically in Fig. 5.38 through Fig. 5.42 for various truck paths and at various locations. Strain plots on the East side of the construction joint for Path Y3 are illustrated in Fig. 5.38 and indicate that the experimental and analytical strains compare well. Strain plots on the West side of the construction joint for Path Y3 are presented in Fig. 5.39 and also indicate that the strains compare well; however, when comparing strains at midspan 1 ft from each side of the construction joint, the data show that the analytical strains are slightly larger than the experimental strains on the East side of the joint (Location L20, shown in Fig. 5.38b) and the analytical strains are slightly smaller than the experimental strains on the West side of the joint (Location L17, shown in Fig. 5.39b). These results verify that the analytical strains are transferred linearly across the construction joint. Further, data are presented in Fig. 5.40 and Fig. 5.41 illustrating strains at various locations on the East curb and on the West curb, respectively. Finally, Fig. 5.42 illustrates typical strains for Path Y2, where Fig. 5.42c shows both analytical and experimental strains across the construction joint and verifies that analytical strains are linearly transferred and that the experimental strains are not transferred linearly across the joint. Table 5.43 illustrates the model accuracy and shows an initial error of 22.3%. The final optimized error is 12.5%; however, the reason of the relatively large error may be that the analytical model could not simulate the non-linear shear transfer across the construction joint.

Table 5.43. Bridge #7: Model accuracy for initial and optimized model.

<table>
<thead>
<tr>
<th>Statistical Term</th>
<th>Units</th>
<th>Initial</th>
<th>Optimized</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total error</td>
<td>microstrain</td>
<td>839</td>
<td>625</td>
</tr>
<tr>
<td>Percent Error</td>
<td>%</td>
<td>22.3</td>
<td>12.5</td>
</tr>
<tr>
<td>Scale Error</td>
<td>%</td>
<td>18.3</td>
<td>12.1</td>
</tr>
<tr>
<td>Correlation Coefficient</td>
<td>N/A</td>
<td>0.92</td>
<td>0.94</td>
</tr>
</tbody>
</table>
Figure 5.38. Bridge #7: Strain plots on the East side of the construction joint for truck Path Y3.

a. Location L19.

b. Location L20.

c. Location L21.
Figure 5.39. Bridge #7: Strain plots on the West side of the construction joint for truck Path Y3.
Figure 5.40. Bridge #7: Strain plots at the East curb for truck Path Y1.
Figure 5.41. Bridge #7: Strain plots at the West Curb for truck Path Y4.

- **a. Location L1.**

- **b. Location L2.**

- **c. Location L3.**
a. Location L14.

b. Location L15.

c. Strains for gages at the bottom of the slab to illustrate shear transfer.

Figure 5.42. Bridge #7: Typical strain plots for truck Path Y2.
By using this optimized model with the appropriate rating trucks and by applying dead load to the structure, the rating model was. Dead load applied in the analytical model includes the self-weight of the concrete slab and a superimposed dead load of 126.8 lb/ft. The superimposed dead load was obtained from calculations previously performed by the bridge engineers at the Iowa DOT and accounts for the steel rail and the additional slab weight. For rating purposes, appropriate design trucks were considered:

- Path A: The driver side wheel line 7 ft from the East curb.
- Path B: The driver side wheel line 12 ft from the East curb.
- Path C: The driver side wheel line 17 ft from the East curb.
- Path D: The driver side wheel line 22 ft from the East curb.
- Path E: The driver side wheel line 1 ft from the West curb.
- Path F: The driver side wheel line 11 ft from the East curb.

Each path was analyzed at 1 ft intervals. This bridge was designed as a two-lane bridge, so truck path envelopes were created to account for two trucks applied on the structure at the same time:

- Envelope 1: Path A combined with Path C.
- Envelope 2: Path B combined with Path D.
- Envelope 3: Path E combined with Path F.

Individual member capacities were calculated following appropriate AASHTO Standard Specifications (4). Ratings by the LFD Method and by using the BDI Software are presented in Table 5.44 and Table 5.45, respectively. Table 5.46 summarizes the percent difference between inventory ratings by the LFD Method and by using the BDI Software. The critical rating condition is 0.77 by the LFD Method and 1.57 by the BDI Method for a difference of 103.9 %.

**Table 5.44. Bridge #7: Design Truck Rating Factors by the LFD Method.**

<table>
<thead>
<tr>
<th>Section</th>
<th>Flexure</th>
<th>Shear</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Inv. Ope</td>
<td>Inv. Ope</td>
</tr>
<tr>
<td>Deck</td>
<td>0.77</td>
<td>1.29</td>
</tr>
</tbody>
</table>
Table 5.45. Bridge #7: Design Truck Rating Factors by the BDI Method.

<table>
<thead>
<tr>
<th>Section</th>
<th>HS-20 Flexure</th>
<th>HS-20 Shear</th>
<th>H-20 Flexure</th>
<th>H-20 Shear</th>
<th>Type-3 Flexure</th>
<th>Type-3 Shear</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deck</td>
<td>1.57</td>
<td>2.62</td>
<td>1.95</td>
<td>3.26</td>
<td>1.61</td>
<td>2.69</td>
</tr>
</tbody>
</table>

a Edge stiffening included.

Table 5.46. Bridge #7: Percent difference in Design Truck Rating Factors between LFD Method and BDI Software.

<table>
<thead>
<tr>
<th>Section</th>
<th>HS-20 Flexure</th>
<th>HS-20 Shear</th>
<th>H-20 Flexure</th>
<th>H-20 Shear</th>
<th>Type-3 Flexure</th>
<th>Type-3 Shear</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Deck</td>
<td>103.9</td>
<td>-7.1</td>
<td>103.8</td>
<td>-15.4</td>
<td>120.5</td>
<td>0.0</td>
</tr>
</tbody>
</table>
6. CONCLUSIONS AND RECOMMENDATION

The following briefly summarizes the information previously presented. In addition, conclusions and recommendations based on this work are provided.

6.1 SUMMARY

- The model development process used herein was verified by comparison with a previously analyzed bridge. The percent error for the model developed by BDI was 6.0 %, while the model described herein using a similar procedure was 5.7 %. Both bridge analyses had a correlation coefficient of 0.97 and had similar section properties in all but one instance.

- The partial proof load test completed for Bridge #1 showed that the model accuracy remains approximately the same independent of the load truck used. A limitation of this partial proof load test is that the bridge was assumed to behave with linear strains: A full truck was used to obtain the optimized model. This model using the full truckload had an error of 1.8 %, while the other truckloads used in the same model gave a 2.4 % and 5.5 % for the half-full and empty truck, respectively.

- Bridge #2 indicated that strains can be predicted at locations without gages installed. The optimized model percent error is approximately the same when including a limited number of gages as when including all gages (to predict strains). The optimized model with a limited number of gages had a 1.8 % error, while the percent error for the same model using gages at predicted locations gave a 2.1 %.

- For the HS-20 load vehicle, most bridges had a flexural rating greater than that obtained using a codified approach. The two steel girder bridges with timber decks had BDI ratings that were 47 % greater (average difference) than the LFD ratings. The three steel bridges with concrete decks tested had BDI ratings that were 57 % greater (average difference). The two concrete slab bridges had BDI ratings that were 117 % greater (average difference). The difference in the rating values for the five steel girder bridges were due to issues such as increased exterior beam stiffness due to the presence of reinforced concrete parapets and presence of unintended composite action. The rating increases for the two concrete slab bridges were credited to a more accurate analysis of a plate structure.

- For the HS-20 load vehicle, most bridges had a shear rating greater than that obtained using a codified approach. The two steel girder bridges with timber decks had BDI ratings that were 49 % greater (average difference) than the LFD ratings, the three steel bridges with
concrete decks tested had ratings that were 40 \% greater (average difference), and the two concrete slab bridges had ratings that were –5.5 \% smaller (average difference).

- **For all critical bridge sections, the BDI Software ratings were greater than the LFD Method ratings.** The critical BDI ratings (one critical rating value per bridge) varied from 0.83 to 1.57 with an average value of 1.28. The critical LFD ratings varied from 0.67 to 1.32 with an average critical value of 0.86. These results indicate that the critical BDI ratings were 48 \% greater than the critical LFD ratings.

- **Strain errors (when comparing analytical with experimental strains) for all investigated bridges varied from 1.8 \% to 12.5 \%.** The two timber deck bridges had an average optimized strain error of 2.0 \% and an average correlation coefficient of 0.99. The three steel-girder bridges had an averaged optimized strain error of 6.0 \% and an average correlation coefficient of 0.97. The two concrete slab bridges had an average optimized strain error of 11.2 \% and an average correlation coefficient of 0.95.

- **All BDI Software ratings for non-composite timber-deck steel-girder bridges are greater than the codified ratings.** The rating values for the BDI Software compared well with the LFD Method. For such bridges, all BDI Software rating values were greater than the LFD Method values.

- **Most BDI Software ratings for composite concrete-deck steel-girder bridges are greater than the codified ratings.** Even though some values were lesser, all critical BDI Software rating values (e.g. inventory rating values less than 1) were greater than the LFD Method values.

- **Most BDI Software ratings for concrete slab bridges are significantly greater than the codified parameters.** Even though the strains on such bridges were difficult to predict, once an optimized model has been created, all ratings for flexure were multiple times greater the codified ratings. However, the BDI Software ratings for shear were slightly smaller in magnitude than the codified ratings.

- **All operating rating values were greater than one when applying both methods.** The critical operating values were 1.37 for the BDI Method (Bridge #4) and 1.12 for the LFD Method (Bridge #6).

### 6.2 CONCLUSIONS

- **The sensitivity of live load moments from the BDI Software depends on selecting accurate values for the location of the neutral axis.** As shown in the sensitivity study for
Bridge #1, the live load moments varied from 1,415 K-in to 1,560 K-in when the location of the neutral axis for an interior beam at midspan was varied by 4 in. This represents an increase of 10%. Further, the model accuracy varied from 7.3% to 5.8% when changing the neutral axis location as described. These results indicate that even though the model accuracy does not change significantly (i.e., “good” models can be created with multiple neutral axis locations), the live load moments may change considerably.

- **It is possible to predict strains at locations where no gages were installed.** As described previously, the optimized model with a limited number of gages resulted in a 1.8% error, while the percent error for the same model using gages at predicted locations had a 2.1% error.

- **Strain behavior for non-composite, timber-deck, steel-girder bridges can be predicted very accurately since the average optimized strain error was 2.0%**. Based on the results for the two timber-deck steel-girder bridges investigated, the optimized models returned strains that correlated very well with the measured strains, and behavior at non-instrumented sections can also accurately be predicted.

- **Strain behavior for composite, concrete-deck, steel-girder bridges can also be accurately predicted since the average optimized strain error was 6.0%**. Based on the results for the three concrete deck steel girder bridges investigated, the optimized models correlated well with the measured strains. However, composite bridges with variable effective slab widths caused problems since it is difficult to accurately predict these widths.

- **Strain behavior in concrete slab bridges can not be as accurately predicted as in steel-girder bridges since the average optimized strain error was 11.2%**. Based on the results from the two investigated concrete slab bridges, the optimized models predicted strains that correlated relatively well with the measured strains. However, as previously discussed, a “good” model has an optimized error of less than 10%. Moreover, these two bridges were atypical regarding bridge behavior (i.e., experimental data indicated strain asymmetry, shear non-transfer, etc.), hence the load distribution was difficult to predict.

### 6.3. **RECOMMENDATIONS**

- **Use of the BDI system for load rating of bridges should be continued.** The finite element approach used in this BDI Software is more accurate than the conventional LFD Method (AASHTO Standard Specifications (4) or other conventional rating procedures), thus more accurate ratings are usually obtained when using the BDI system.
• Diagnostic load testing results can be used to extrapolate load ratings for significantly heavier trucks. As described previously, Bridge #1 proved that it is possible to predict strains with heavier trucks. However, this conclusion depends on linear bridge behavior, and if non-linear behavior is expected, further load testing regarding these issues are recommended to observe the bridge behavior under such circumstances.

• The following policy and procedure recommendations have been developed for bridge load evaluation decisions:
  o Steel-girder bridges with timber decks usually exhibit non-composite behavior and insignificant end restraint.
  o Unintended composite action may occur on steel-girder bridges with concrete decks even if they are designed as non-composite.
  o Most steel-girder bridges with concrete decks exhibit significant end restraint even if the end restraint conditions do not indicate such behavior.

• Load evaluation results from systematic testing of a significant number of bridges of one type to other similar untested bridges may be extrapolated as follows:
  o It is only possible to make a statement about the steel-girder bridges with timber decks since the strains in these bridges were accurately predicted: the HS-20 LFD Method rating factors will be similar to the BDI rating factors by a factor (once the LFD Method rating factor is obtained, one can calculate the BDI Method rating value by multiplying the LFD Method rating factor by a factor). This assumption applies for both flexure and shear.

• Investigation of more conventional concrete slab bridges with the BDI system is recommended. The two concrete slab bridges tested in this investigation (e.g. Bridge #6 and Bridge #7) do not represent “normal” behavior due to:
  o The non-symmetric behavior in the transverse direction, and the earth-fill that made it difficult to install gages on top of the slab, thus neutral axis locations were not possible to obtain (Bridge #6).
  o The construction joint that did not transfer loads linearly across the joint (Bridge #7).
REFERENCES


ACKNOWLEDGEMENTS

The investigation presented in this report was conducted by the Bridge Engineering Center under the auspices of the Center for Transportation Research and Education at Iowa State University. The research was sponsored by the Highway Division of the Iowa Department of Transportation and the Iowa Highway Research Board under Project TR-445.

The authors wish to thank numerous staff within the Office of Bridges and Structures at the Iowa DOT, including Norm McDonald, Ahmad Abu-Hawash, Scott Neubauer and Bruce Brakke for their technical guidance and input during the study. Additionally, the assistance of the field bridge maintenance personnel in providing traffic control and snooper access to the underside of the bridges is gratefully acknowledged. Dave Anthoney, County Engineer for Boone County, is also recognized for providing information and personnel for load tests on two bridges in his county.

Special thanks are accorded the graduate and undergraduate students in the Civil and Construction Engineering Department at ISU for their assistance with the field tests.
APPENDIX A

STATE ENGINEER’S QUESTIONNAIRE
Development of a Bridge Load Testing Process for Load Evaluation

Please answer all eight (8) questions in this voluntary survey to the best of your ability. Before completing the survey online, you may wish to review it and gather any information you may need.

If you have questions about the survey, please contact Dr. Brent Phares, 515-294-5879, bphares@iastate.edu
Bridge Engineering Center
Iowa State University Research Park
2901 S. Loop Drive, Suite 3100
Ames, IA 50010.
If you experience difficulties with this web page, please contact the webmaster.

Contact information

Organization: 
Questionnaire completed by: 
Position/Title: 
Address: 
City/State/Zip: 
Phone No.: 
Fax No.: 
Questionnaire

1. Are you currently using nondestructive load testing, proof or diagnostic, for the purposes of rating bridges?
   - a) Yes, both proof and diagnostic testing.
   - b) Yes, proof testing only.
   - c) Yes, diagnostic testing only.
   - **If yes**, approximately how many bridges are tested per year?
   - d) No, but planning on starting a program.
   - e) No, no bridge testing for rating purposes.

   **If no**, please explain why not (this completes the questionnaire).

2. Do you have formal policies and procedures in place as to how bridge test data are used, i.e., for rating purposes or in general?
   - No
   - **Yes**

   **If yes**, please describe your policies and procedures. (If a formal document exists, please send a copy to Brent Phares at the address above.)

3. Does your state DOT
   - a) conduct the testing in-house.
   - b) contract with consultants for testing.
   - c) use a combination of in-house and consultant testing.
4. Is a commercial testing system used?
   ☐ No
   ☐ Yes

   If yes, what system?

5. Do you use a commercial software program to verify field data?
   ☐ No
   ☐ Yes

   If yes, what program?

6. For the following hypothetical bridge, how much would be budgeted for the nondestructive testing, analysis, and load rating?

   Thirty-year-old, 60-ft, simply supported single span bridge carrying two-lane road (medium ADT) over a small creek, maximum height above the creek is 15 ft.

   Superstructure: Steel, five-girder superstructure (rolled shapes); composite concrete deck. Substructure: Concrete abutments.

   ☐ a) Less than $5,000
   ☐ b) $5,000 to $10,000
   ☐ c) $10,000 to $15,000
   ☐ d) More than $15,000

7. When calculating ratings, do you allow to be present, but not codified, one or more of the following bridge properties? (you may select more than one)
   ☐ a) unintended composite action
   ☐ b) edge rail stiffness
   ☐ c) restraint at the abutments or piers
   ☐ d) other

   If you selected "other," please specify.

   ____________________________
8. Do you extrapolate the results from load testing to issue permits for overload vehicles?

☐ No
☐ Yes

If yes, what are your policies related to load testing and permit vehicles?

Would you like to receive a copy of the survey results?

☐ No
☐ Yes

Thank you for completing this survey!  

Submit Survey
APPENDIX B

COUNTY ENGINEER’S QUESTIONNAIRE
Development of a Bridge Load Testing Process for Load Evaluation

Please answer all questions in this voluntary survey to the best of your ability.

This research is sponsored by the Iowa Highway Research Board and the Project Development Board of the Iowa Department of Transportation.

If you have any questions about the survey, please contact Dr. Brent Phares, 515-294-5879, fax: 515-294-0467
bphares@iastate.edu

Bridge Engineering Center
Iowa State University Research Park
2901 S. Loop Drive, Suite 3100
Ames, IA 50010

Contact Information

Organization:
Questionnaire completed by:
Position/Title:
Address:
City/State/State:
Phone No.:
Fax No.:
Email Address:
Questionnaire

#1 Are you currently using nondestructive load testing, proof or diagnostic, for the purposes of rating bridges?

a) Yes, both proof and diagnostic testing.
b) Yes, proof testing only.
c) Yes, diagnostic testing only.
   **If yes,** approximately how many bridges are tested per year? ______
d) No, but planning on starting a program.
e) No, no bridge testing for rating purposes.

**ANSWER:**

**If no,** please comment on why not.
__________________________________________________________________________________
__________________________________________________________________________________
_________________________________________________________________________

#2 Does your organization

a) conduct the testing in-house.
b) contract with consultants for testing.
c) use a combination of in-house and consultant testing.
d) use State DOT forces

**ANSWER:**

#3 For the following hypothetical bridge, what would you budget (if currently using nondestructive load testing) or be willing to budget (if not currently using nondestructive load testing) for testing, analysis, and load rating?

Thirty-year-old, 60 ft, simply supported single span bridge carrying two-lane road (medium ADT) over a small creek, maximum height above the creek is 15 ft.

*Superstructure:* Steel, five-girder superstructure (rolled shapes); composite concrete deck.
*Substructure:* Concrete abutments.
a) Less than $5,000
b) $5,000 to $10,000
c) $10,000 to $15,000
d) More than $15,000

ANSWER:

Would you like a copy of the survey results?

a) No
b) Yes

ANSWER:

Thank you for completing this survey!
APPENDIX C.

A STEP-BY-SSEP PROCEDURE FOR BRIDGE RATING BASED ON
PHYSICAL TESTING
Input clicker distance manually for all truck path files:

- Open the first truck path file (dat-file) in WordPad or Notepad. Scroll down to the bottom and input the correct field clicker distance.
- Repeat for all truck path files.

If two strain files for each path are created, verify that both files are approximately the same:

- Open the two files in WinGRF and compare the strains. Choose linear drift if it desired to zero the field strains at start and finish of field data information.
  - File → Load STS Data File → Open both files → Linear drift both files
- Select appropriate locations to compare strains for the two chosen files.
  - Data comparison → Strain plots
- Repeat for all truck paths

Average and filter the two strain files for each path to create one file for each path be used in the modeling process:

- For Path Y1, open the two raw field strain data files in WinGRF.
  - File → Load STS Data File → Open both files → Linear drift both files
- Average the two raw data files.
  - Data Processing → Average STS files → Save as “average_Y1” → OK
- Open the averaged file in WinGRF and decimate to smoothen out the graph.
  - File → Load STS Data File → Open “average_Y1” → Linear drift → Data Processing → Filter/Decimate → OK → Save as “filter_Y1”
- Repeat for all truck paths. All strain files used from here are the “filter_Y”-files (not the raw data files or the “average_Y”-files).

Verify strain symmetry:

- Check field strains in WinGRF for symmetric truck paths in the transverse direction to verify strain symmetry.
- Repeat for symmetric paths in the longitudinal direction.

Locate the neutral axis to determine any composite section at a selected location:

- Check field strains in WinGRF by comparing strains at top and bottom gages at the selected location. The neutral axis location should lie at the center of the web for a symmetric non-composite steel beam. A neutral axis location near the top flange is an indication of composite action for the selected section.
  - Data comparison → Neutral axis plots.
Observe if the bridge exhibits any end restraint:

- Select an appropriate truck path. Select strain locations near the abutment or near the pier (if any) and observe the presence of tension in the top flanges (if the neutral axis location lies below the top flange) and compression in the bottom flanges.

**Create an analytical one-span bridge model in WinGEN by using the filtered strain file:**

- Define model geometry, plan parameters, and transverse members for “Bridge #1”. Add transverse members where floor beams are located.
  - File → New Model File → Model Geometry → Beam/Slab Bridge → Enter “Bridge #1” → Define Plan Parameters → Enter parameters → OK → Span Length/Beam Spacing → Enter Parameters → Transverse Members → Add transverse members → Done
- Add spring locations:
  - Define Plan Parameters → Enter parameters → OK → Span Length/Beam Spacing → Enter Parameters → Spring Locations → Add Springs → All done
- Create a W27x84 steel cross-section:
  - Model Parameters → Define X-section → AISC Steel Sections → W33–W27 → W27x84 → OK
- For any cross-sections not defined in the software, the user must define the sections:
  - Model Parameters → Define X-sections → Create New Cross-section → User defined → Add Quadrilateral → Enter parameters → OK
- Assign the W27x84 to the model:
  - Model Parameters → Assign X-sections → “Select group” → Assign Group → Assign by dragging over the desired elements, and right-click when done → OK
- Repeat for all cross-sections, such as concrete slab deck, rotational spring, curb dimensions, and user defined sections.
- Apply Boundary Conditions so that bridge is simply supported:
  - Model Parameters → Boundary Conditions → Check displacement boxes in X- Y- and Z-direction → Assign BC → OK
- Define field truck:
  - Load Definition → Define Truck → OK
- Define Truck Paths:
Load Definition → Define Truck Paths → Add Path → “Enter parameters” → Apply → OK

- Retrieve field test strain data and apply to model:
  - Model Parameters → Retrieve STS Data → Check “Linear Varying Offset” → STS Data File → Select “filter_Y1” → Apply secondary gage factors if strain gages other than standard has been used → Apply → OK
- Repeat for all truck paths.
- Enter optimization parameters:
  - Model Parameters → Optimization Parameters → New Variable → W27x84 → Select “Iy” → Set lower limit to 80 % of non-composite value and upper limit to 120 % of composite value → OK → OK
- Repeat for all desired parameters.
- Select analysis options for optimization:
  - Analysis → SAC Options → Check “STS Data Comparison” and “Parameter Optimization” → OK
- Save both model file and analysis file:
  - File → Save Model File As → “Model”
  - File → Save SAC File as → “Model”
- Two files have now been created. The model file is named Model.mod, and the analysis file needed to run SAC is named Model.inp.

Run the input analysis file using WinSAC:
- File → Open → “Model”
- SAC will perform iterations and change the user defined optimization parameters in order to reach the smallest strain difference between the analytical and experimental strains.

View input/output/strain/property files in SAC:
- View data → Input/Output/Strains/Properties

Create a new model in WinGen and update the optimized properties to use for HS-20 truck rating:
- The updated optimized model will be named Updated.mod.
  - File → Open Model File → “Model” → File → Save Model File As → “Updated” → Model Parameters → Define X-sections → Update (optimized) parameters → “Model” → Done → File → Save Model File As → “Updated” → OK
- However, the optimization box needs to be checked off.
Analysis → SAC options → Check off “Parameter optimization” → File → Save Model File → File → Save SAC File As → “Updated”

Run updated analysis file in SAC to verify that the model accuracy is the same:
File → Open → “Updated”

Use the updated file and apply dead load in WinGEN:
Load Definition → Dead Load → Self Weight → Check box so that program will apply the self weight of the user defined parameters → OK

- Additional dead load, such as gravel/dirt/asphalt overlay and rail must be added.

Apply HS-20 Design Truck to model in WinGEN:

- Load truck dimensions from the library if there is one. If not, create a new truck as previously described.
  Load Definition → Define Truck → Library → Library File → HS-20 → OK
  Load Definition → Define Truck Paths → Truck (library) → HS-20 → OK → Apply → Adjust Parameters so that the truck will be in critical position with appropriate longitudinal intervals → Apply → OK
- Apply additional truck paths with appropriate transverse intervals.

Apply rating factors in WinGEN:

- For LFD Method, the Dead Load Factor is 1.3, the Live Load Factor is 2.17, and the impact is 0.3 (use AASHTO Standard Specifications for more exact impact factor).
  Rating → Load Factors → “LFD” → 1.3 → 2.17 → 0.3 → Save Method → OK

Enter Capacities for W27x84 in WinGEN:

  Rating → Capacities → Enter “LFD” → New Method → Select W27x84 → Enter capacities as desired → Apply → OK
- Repeat for all desired section parameters.

Input truck path envelopes in WinGEN if the bridge is designed for two or more trucks:

  Rating → Combine Truck Paths → Add Combination → Select appropriate design truck paths → Apply → OK
- Apply additional truck path envelopes if necessary.
Save rating option in WinGEN:

- Analysis → SAC options → Check “Perform Load Rating” → OK
- File → Save Model File As → “Rating”
- File → Save SAC File As → “Rating”

Run analysis file in WinSAC to perform load rating:

- File → Open → “Rating”

Extract Live Load Moments by exploring the output file in SAC:

- View Data → Output

Repeat for other rating truck vehicles as desired (e.g. H-20, Type-3, etc.)